# Table of Contents

**VERSION UPDATES** ........................................................................................................... 4  
**GETTING STARTED** .......................................................................................................... 6  
  **INTRODUCTION** .............................................................................................................. 6  
  **SYSTEM REQUIREMENTS** ............................................................................................ 7  
  **DISCLAIMER & LICENSE** ............................................................................................ 8  
  **ACKNOWLEDGEMENTS** ............................................................................................... 9  
  **HELPFUL HINTS TO KEEP IN MIND** ........................................................................... 10  
  **FILE PREPARATION AND ORGANIZATION** .............................................................. 11  
  **PROGRAM INSTALLATION AND START-UP** .............................................................. 12  
  **TUTORIAL: EXAMPLE WALKTHROUGH** .................................................................... 13  
    **OPTION: Preparing a Batched Queue** ........................................................................ 14  
  **IMPORT MEG** .............................................................................................................. 15  
  **CREATE EVENTS** ......................................................................................................... 22  
  **MRI VIEWER / HEAD MODELS** .................................................................................. 26  
    **Important Note on Importing DICOM Files** ............................................................. 26  
    **OPTION: Using T1 and T2 images for improved surface extraction** ..................... 32  
    **OPTION: Alternative Head Model Calculation – Extract “Surface Hull” from CIVET/FreeSurfer Surfaces** ................................................................. 34  
    **OPTION: Utilizing “Surrogate” MRIs** ..................................................................... 36  
  **SINGLE SUBJECT ANALYSIS** ..................................................................................... 40  
    **OPTION: Render Subject Volumetric Image onto 3D Adult Template Surface (CH2)** ........................................................................................................... 48  
  **GROUP IMAGE ANALYSIS** .......................................................................................... 50  
  **GROUP VIRTUAL SENSOR (VS) ANALYSIS** ............................................................... 55
BrainWave v3.5

Archive: AVERAGE / PERMUTE IMAGES ................................................................. 57

PROGRAM NAVIGATION ......................................................................................... 60

NAVIGATING THE MAIN MENU .............................................................................. 61
  Import MEG: Import Continuous Datasets ............................................................ 62
  Import MEG: Create Events ................................................................................. 68
  MRI Viewer/Head Models ...................................................................................... 71
  Single Subject Analysis ......................................................................................... 76
  Group Image Analysis ............................................................................................ 82
  Group VS Analysis .................................................................................................. 85
  Archive: Average/Permute Images ....................................................................... 88

NAVIGATING GENERATED FIGURES/IMAGES ......................................................... 90
  Beamformer: Volumetric Images ......................................................................... 91
  Beamformer: Surface Images ............................................................................... 95
  The Virtual Sensor (VS) Plot ............................................................................... 99
  The Time-Frequency Representation (TFR) Plot ..................................................... 102

Appendices .................................................................................................................. 106

APPENDIX 1: Minimum-Variance Beamforming and SAM Calculations .............. 107

APPENDIX 2: Calculation of the Forward Solution ................................................. 114

APPENDIX 3: File Formats ....................................................................................... 116

APPENDIX 4: CIVET and FreeSurfer Surface Files ................................................. 125

APPENDIX 5: How BrainWave Uses Continuous Head Localization (CHL) ............ 128

REFERENCES ............................................................................................................. 131
Latest Version Features

- **Demonstration Datasets (now available).**
  - Our recent publication¹ references a database to demonstration datasets as well as provides additional tutorial methods specific to the datasets provided (https://figshare.com/s/2e1c6559cadae29429bc).
- **CentOS 6.0 and 6.5 / Windows 7 and 10 / Mac OS X El Capitan and High Sierra tested.**
- **Import Data.**
  - Order of operation updates to improve speed of data import and epoch rejection.
  - Added auto-channel rejection based on a given percentage of bad trials.
  - Auto display of rejected channels for review (if exceeding rejection percentage)
- **Images**
  - Able to input time value to "jump" to a desired latency.
- **TFR**
  - Multiple colormap options have been added.
- **Permuted Images.**
  - Able to generate Plot VS and Add to Peak List by utilizing the group image coordinates (if significant).

Bug Fixes

- **Hard-coded errors.** Xcopy commands missing for Windows OS; Group images were not displayed due to hardcoded backslashes; MouseDownEvent error displayed with Plot Average fixed.
- **Off-screen windows.** All opened windows now forced to appear mid-screen for Windows OS versions ONLY. Other OS's experienced “jumping” displays – this has been fixed.
- **Multiple smaller fixes.**

Known Software Incompatibilities

- **Mac OS High Sierra (10.13) and SPM12.** Must use newest SPM12 version (build 7219 tested).

**BrainWave v3.5**

- **MATLAB 2015-2016 version graphics issues.** Mathworks made changes to the MATLAB graphics engine with the release of MATLAB 8.4 (2014b) that causes serious slowdowns for some MATLAB figure generation codes, including those used by BrainWave. It is therefore highly recommended to utilize MATLAB 8.3 (2014a) or earlier for Mac OS. Later versions of Mac OS (e.g., Sierra) may require additional patches to run MATLAB until the 2016b release. Please visit the MATHWORKS website for more details.
INTRODUCTION

*BrainWave*® - Beamformer Reconstruction And INteractive WAveform Visualization Environment, is a user-friendly, special purpose, Matlab-based graphical user interface (GUI) for the computation of beamformer source images and waveforms from magnetoencephalography (MEG) data. It utilizes an integrated viewer for visualizing 4-dimensional image sequences, with simple point-and-click waveform and time-frequency plotting. *BrainWave* can also be used to perform MRI based spatial normalization and group analysis of source images using the SPM® Matlab toolbox (installed separately). The documentation provided here will guide you through the basic features of this software package via program navigation screenshots as well as a brief tutorial on the basic set-up of your MEG data for analyses. *BrainWave* is not intended to be an extensive data editing or sensor-level analysis toolbox for MEG data, or to replace editing and data processing features that are already available in various MEG software packages. However, basic data preprocessing (editing, filtering and epoching raw data) and MRI importing and co-registration tools are provided, such that *BrainWave* can be used as a stand-alone data analysis toolbox for generating and viewing beamformer based source images at both the single subject and group level. *BrainWave* uses the CTF MEG4 dataset (.ds) file format as its native format. Conversion utilities are provided to import MEG data from other MEG vendor formats by first converting them to the CTF .ds format.
SYSTEM REQUIREMENTS

Hardware
• *BrainWave* uses compiled C-mex functions for optimization and efficient handling of MEG data. C-mex functions are currently provided for: Linux (64 bit versions);
  • Mac OS X (version 10.6 or later required) and;
  • Windows (Windows 7 64 bit or later required)
• Multi-core Processors & a minimum 4 GB of RAM is recommended for the fast computation of beamformer images via multi-threaded libraries.

Software
• MATLAB Version 7.5 (http://www.mathworks.com/) or higher is required.
• MATLAB Signal Processing Toolbox is required for Hilbert Transformation analyses, but otherwise NO toolboxes are required.
• Statistical Parametric Mapping (SPM8 or SPM12) is required for spatial normalization and group analyses. Welcome Trust Centre for Neuroimaging, UCL, London (http://www.fil.ion.ucl.ac.uk/spm/software/spm8/).
• University of Oxford’s FMRIB Software Library (FSL) is recommended for a fast extraction of surfaces from MRI images (http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FslInstallation)
• CIVET and FREESURFER is recommended for high resolution surface extractions for three dimensional surface rendered beamforming. Please visit the following sites for more information (http://www.bic.mni.mcgill.ca/ServicesSoftware/BasicUsageOfCIVET and https://surfer.nmr.mgh.harvard.edu/fswiki/DownloadAndInstall)
• fiff2ctf (Elekta/Neuromag users ONLY) Currently compiled for Linux users only.
• *BrainWave* works natively with the CTF Systems MEG data format (.ds files), however the CTF MEG4 software suite does not need to be installed to run *BrainWave*.

Demonstration Datasets
• If choosing to use our demonstration datasets, the file *reorganize.m* is located with the files, found here: https://figshare.com/s/2e1c6559cadae29429bc
DISCLAIMER & LICENSE

This software package was developed by Dr. Douglas Cheyne and other contributors (listed under Acknowledgements) at the Toronto Hospital for Sick Children Research Institute, and supported by research grants from the Canadian Institutes of Health Research (MOP62479) and the Natural Sciences and Engineering Research Council of Canada (CPG104310). This program is provided free of charge without guarantees or warranty. It is intended for RESEARCH PURPOSES ONLY, and has NOT BEEN APPROVED FOR CLINICAL USE. This software is copyright of the developer and Hospital for Sick Children and is not to be distributed without permission by the developer. Errors encountered using the program may be reported using our on-line mailing list or directly contacting us at brainwave.megsoftware@gmail.com. To obtain a copy of the software, please visit http://cheyanelab.utoronto.ca.
ACKNOWLEDGEMENTS

The BrainWave interface and overall design was carried out by Natascha van Lieshout and Douglas Cheyne. Documentation prepared by Cecilia Jobst and Douglas Cheyne. Many other individuals have contributed to the BrainWave toolbox including (in alphabetical order), Sonya Bells, Andreea Bostan, Wilken Chau, Zhengkai Chen, Teresa Cheung, Paul Ferrari, Tony Herdman, Cecilia Jobst, Marc Lalancette, Brad Moores, Merron Woodbury and Maher Quraan. Wavelet transformations algorithms are modified from Ole Jensen’s 4D toolbox. The NIfTI file conversion routines were written by Jimmy Shen, (http://www.rotman-baycrest.on.ca/~jimmy/). Talairach conversion based on Talairach database available at http://www.talairach.org. The tooplot Matlab routines are from the EEGLab package by Colin Humphries & Scott Makeig, CNL / Salk Institute. The SPM toolbox is available from the Welcome Trust Centre for NeurolImaging, Institute of Neurology, University College of London.
Helpful Tips to Keep In Mind...

✅ Always monitor the MATLAB command window output when processing data. It is here where you will find details of what parameters were used, the results of various processes, and important warnings or whether any errors were encountered.

✅ Organize your datasets as described in this documentation (see the next section on File Preparation and Organization). BrainWave has been designed to minimize the amount of searching for data and associated files, and to work as seamlessly as possible with CTF MEG data formats.

✅ Look for the ⚠️ symbol throughout this documentation. It will denote important notes and tips you might find helpful!

✅ Can’t find the answer to your question? Let us know! We’re happy to help!
**FILE PREPARATION AND ORGANIZATION**

**Step 1: Prepare your datasets**

*BrainWave* uses the following naming convention for EPOCHED (i.e., raw data segmented into trials) datasets:

```
subjectID_StudyOrConditionName.ds
```

where subjectID is the subject identifier and is delimited by *BrainWave* as anything prior to the **FIRST UNDERSCORE** (may be characters or numbers). Anything following the first underscore is up to you, though typically, you would include the study name and/or condition name here and/or anything to help identify the task performed. **SubjectID is REQUIRED** and must match the subject identifier of their MRI folder name, e.g., subjectID_MRI. Preparing your datasets may be done manually (e.g., using CTF commands), or automatically using features provided in our **Import MEG** command window. MRI folders are auto generated when raw MR files are imported into our **MRI Viewer/Head Models** command window.

⚠️ **When choosing a name, DO NOT USE SPACES OR DASHES, AND IT IS HIGHLY RECOMMENDED TO AVOID LONG DATASET NAMES.**

**Step 2: Organize your datasets**

To help *BrainWave* find your datasets and MRI folders, the following dataset organization is **REQUIRED**:

```
Common Study Folder
  data
  All Subject Folders at Same Level
    SubjectID_*.ds
    SubjectID_MRI
    Files
      *.meg
      *.hdm
      ...
      *.nii
      *.off
      ...
```

where all subject data folders (*.ds and *_MRI folders) should be saved within a common study dataset folder (e.g., “data”, but can be named anything). Note that each subject folder will contain associated files, such as head models (*.hdm), and FSL extraction (*.off) files. These files and more will be described in more detail later on in this documentation.
If applicable, ensure entire CIVET or FreeSurfer (third-party cortical surface extractions) folders are accessible by BrainWave for each participant. Saving the entire folder within a new individual subject folder (e.g., 001_surfaces) at the level of all subject folders, or within the subject MRI folders are recommended.

**PROGRAM INSTALLATION AND START-UP**

**Step 1: Download software and unzip BrainWave**

Software can be found here [http://cheynelab.utoronto.ca](http://cheynelab.utoronto.ca).

Unzip the downloaded file and save the folder to a desirable location on your computer.

**Step 2: Add all necessary programs to MATLAB path**

Add *BrainWave* folder, *SPM8* (and *FSL*) folders to your MATLAB path.

**Step 3: Launch BrainWave**

In the MATLAB command window, type the following command:

```
>> brainwave
```
The following will demonstrate a typical step-by-step example of how to analyze MEG data from raw data to group analysis. Additional information about every feature within each window will be provided in detail in the program navigation and appendix sections of this manual.
OPTION: Preparing Batched Queue

- Preparing multiple datasets for analysis can be tedious. BrainWave offers the ability to set up all subjects and analyses in queue to allow all processes to run sequentially without the wait.

- Currently available for Import Data, Group Image Analysis and Average/Permutation features. For each, the setup is the same:
  - Go to dropdown menu **Batch → Open new Batch**… A prompt will confirm whether you’d like to continue. Click **Yes**.
  - Prepare up your analyses as usual for the first group.
  - Click **Add to Batch** (or **Generate Group Images** or **Permute**)
  - A prompt will ask whether you would like to add the image to a batch. Clicking **Yes** will store all current settings until the batch is ready to run.
  - You may now setup a completely new group analysis with different parameters,
  - When the second analysis is prepared, click **Add to Batch** (or **Generate Group Images** or **Permute**) again to add this to the queue.
  - The updated number of processes can be found in the **Batch** dropdown menu.
  - When you are ready, go to **Batch → Close Batch**…
  - To run all processes, go to **Batch → Run Batch**…
Step 1: Load raw dataset.

- Go to File -> Load CTF Datasets..., then select a raw, CONTINUOUS (one trial only) dataset (e.g., CTF datasets will have *.meg4, Yokogawa will have *.con).
  - Use Import MEG data... in order to load KIT/Yokogawa (*.con) or Elekta/Neuromag datasets (*.fiff).
  - Yokogawa datasets will automatically convert into CTF dataset format upon import.
  - Importing Elekta/Neuromag datasets (*.fiff) will provide a prompt “Convert 1 datasets to CTF format?”
- If the dataset is raw (continuous, or non-epoched), fif2ctf (v.1.2.0) will begin the conversion into CTF format. This may take several minutes. **LINUX DISTRIBUTIONS ONLY.**
• Once created, a secondary code will search for STI101 and STI201 channels (typical event-coded channels) to create a customized CTF-format MarkerFile.mrk file.

• In all cases, an error will occur if you try to open a dataset with more than one trial, such as an already epoched dataset, or a larger (> 2 GB) continuous file that contains multiple raw files (e.g., *.1_meg4, *.2_meg4, etc... which occurs with longer scan times or higher sampling rates).

Step 2: Select and epoch to a specified event.

• In the Epoch Selection panel, select the Use Event File radio button and click the Load Event File button.

• A prompt will ask you to navigate to a marker file (*.mrk, CTF systems), event files (.evt, Yokogawa systems) or other custom latency text (.txt) file.

  ○ See Create Events section on how to add custom events (e.g., EMG onset) to current event files (*.mrk only) and/or save custom event files (as *.txt files). This feature is available for CTF datasets only.

• Select an event from the drop down menu, and press OK.

  • All time points for when that event occurred will appear in the epoch latencies box. Note that any excluded epochs will be notated with **.

  • Next, set your time window of interest in the epoch start and end boxes (in values of seconds).

  • If needed, add a minimum separation time value (in seconds) to ensure that events do not occur too close together in time.
• If there is a known latency delay (e.g., the time it takes for a visual stimulus to reach the subject’s visual display in the MEG is a known projector lag), include this value in the **Latency Correction** window.

**Step 3: (Optional) Pre-Processing**

a. **Filter data**
   - Filtering is not always necessary when pre-processing datasets. However, if needed, select the **Filter Data** checkbox in the **Pre-Processing** panel and input your bandpass parameters.
   - **Use expanded filter window** will help to correct filter edge effects. This will first apply the filter to a larger window of data (50% more data points on either end) then truncate the filtered data to the specified window length thus eliminating averaged edge effects.

b. **Filter Powerline**
   - Optionally filter out power line frequencies prior to analyses (60 Hz and 50 Hz available).

c. **Downsample data**
   - Downsample your loaded dataset by first enabling the **Filter Data** box in the **Pre-Processing** panel. Data will be filtered to the bandpass shown in the **Sample Rate** dropdown prior to downsampling.
   - To avoid aliasing, a minimum low pass filter cutoff of 1/3 the desired downsampling rate will be calculated. The allowable sampling rates in the dropdown menu are automatically updated whenever a new low-pass is inputted.
   - For example, to downsample from 2400 Samples/s to 600 Samples/s, you would first input a **lowpass** filter (1/3 of 600 Hz is 200 Hz), then select the downsample value from the **Sample Rate** dropdown (600 Samples/s).

d. **Remove Faulty or Unwanted Channels**
   - The **Preview** panel will display the current status of a selected epoch latency and MEG channel(s) (see
Preview section below on how to view multiple channels at once). MEG channels that need to be removed (faulty or otherwise) from analyses may be done using the Edit Channels feature in the Pre-Processing panel.

- Simply find the channel you would like to remove, then click the rightward arrow to place it in the Exclude list. The channel will appear in grey on the sensor helmet figure above. Select from a predefined set of sensors for removal, or save a customized list which will append to the Channel List options list. Click Apply to remove sensor(s) from your new dataset.

e. Head motion trial rejection (*CTF System Datasets Only*)

- **USE THIS FEATURE AS A LAST STEP** as ANY changes to the epochs (e.g., time window size, deleted latencies, changed filters, etc.) will require a recalculation of the mean head position across the newly adjusted set of trials.

- Datasets collected from an MEG system with continuous head localization (CHL) capabilities will enable the Use mean head position option in the Pre-Processing panel.
• When selected, the mean head position of all currently valid epochs (i.e., trials/latencies with no stars) will be calculated

• This mean head position will be used to update the mean location of the fiducial coordinates (which will now be highlighted in red in the *Data Parameters* panel).

**f. Automatic Epoch Rejection (Artifacts and Head Motion)**

![Warning Symbol] Be sure to use this feature conservatively. You can monitor the number of trials removed in the MATLAB Command Window.

• Choose one or all automatic epoch rejection features within the *Epoch Rejection* panel.

1. **Exclude epoch if... peak-peak amplitude exceeds [XX] picoTesla.**
   
   • Each trial will be scanned for large, unwanted deflections (or artifacts) in the data, and will remove all trials where all sensor’s peak-to-peak amplitude exceeds a specified value (default = 2.5 picoTesla).

   • Trial rejection may also be applied to only specified sensors that exceed this limit. To do this, enable the *Scan Selected Channels Only* option, then multi-select your channels from the *Preview* panel *MEG Channel* list.

2. **Exclude epoch if... reset detected (amplitude step exceeds) [XX] picoTesla**

   • Detects the large, sudden signal amplitude jumps often due to interference.

3. **Exclude epoch if... mean sensor motion exceeds [XX] centimeters.**

   ![Warning Symbol] Only available for CTF Datasets.

   • Each trial will be scanned for large, unwanted head movements. This feature removes trials where the current fiducial
position exceeds (default = 0.5 centimeters) the mean head position across all current trials (see Appendix 5 for more information on how BrainWave utilizes Continuous Head Localization (CHL) from CTF systems for head localization).

4. **Exclude Channels where number of trials rejected exceeds [XX] percent.**

   - Determines whether a high percentage of trials are being rejected because of a particular problematic channel or group of channels. If the number of rejected trials exceeds the percentage allowed, a pop-up will inform you of how many channels were the cause of the high rejection rate.
   - Click *Edit Channels* to view which channels were the cause of the high rejection rate, and edit as necessary. *Ignore* will remove all without editing.
   - Click *Scan Epochs* to perform rejections scan. Excluded latencies (indicated with **) will update in the latencies list.
   - **Reset** will reverse all rejections.

**Note:** The *Scan Epochs* operation can be performed multiple times without undoing the results of the previous rejection scan. This allows you, for example, to use different rejection criteria (e.g., different channel selections) to reject trials using amplitude steps or head motion.

**Step 4: Preview.**

   - Preview the quality and status of every trial and every channel of your new dataset before creating it within the *Preview* panel.
   - Monitor updates as changes are made throughout the setup and preprocessing steps described above.

**Step 5: Create dataset.**

   - The final step is to create your new epoched dataset.
• Save average and de-identify data (**see note below) will apply to the resulting dataset upon clicking **Create Dataset**.

• View the MATLAB command window to check its progress.

⚠️ **IMPORTANT NOTE**:
The de-identify data option is not a thorough scrub. Selecting this option will scrub some CTF header fields that often contain sensitive information, but will depend on your facility’s participant registration protocols. Be aware that subject names or other identifying information may still reside in other fields, and should be checked manually.

Step 6: Combining multiple datasets (Optional).
• To combine multiple datasets (continuous or trialed datasets will work), go to select File -> Combine Datasets... (*.ds file) and navigate to your first dataset. Click **Open**.

• The window will reappear, prompting for your second dataset. Click **Open**. Continue this for as many datasets as you’d like to combine.

• When you’re done, simply select **CANCEL** to end the loop.

• A final GUI window will ask you to name your new dataset. By clicking OK, your files will append in order.

• This dataset may now be used like any other dataset from pre-processing to analysis.
Create Events  

Available for CTF Format ONLY.

**Step 1: Open Create Events window.**

- In *Import MEG Data*, load a raw, continuous dataset from the File dropdown menu.

- Select the **Use Event File** radio button within the *Epoch Selection* Panel and click the enabled **Create Events** button (see portioned image of *Import MEG Data* window below).

- A new window will appear (see above image).
Step 2: Load a channel.

• The Channel dropdown menu at the top of the window contains all channels within the MEG dataset collected at the time of the recording (e.g., EMG or microphone or button response).

• Scroll to select the channel that you would like to use for customized event marker placement. Depending on the size of the dataset, this may take a few moments to load.

  o At this time, you may only select and apply events to one channel at a time. Similarly, you may only view only one marker at a time. Saving then reloading these event files will allow you to view them with other channels.

• If present, the CTF MarkerFile.mrk events will automatically be uploaded into the Marker dropdown window. Otherwise, you may load any accepted event files (*.evt, *.mrk or *.txt). Loaded markers (in green) may help you to better navigate the dataset and ultimately decide where new event markers should be placed.

Step 3: Preview and adjust parameters.

• All adjustments made here are for your current viewing needs, and will NOT be saved to the dataset. This feature is only intended to allow for accurate custom time marker placement.

• Adjust the Scale Minimum/Maximum (y-scale or “gain”) to your preference using the up/down arrows located beneath the preview window.

• To adjust your time scale, input the desired time window value (in seconds) in the Epoch Duration box.

• DC Offset may be required to “pull” the data down into view.

• Select the Filter checkbox enable bandpass (High Pass and Low Pass) customization.

• A 60 Hz powerline notch filter can be applied by enabling the 60Hz checkbox.

• Rectify will set all dataset amplitude values to positive values
• **Invert** will flip the amplitude values to its opposite value.

• The option to **Differentiate** is useful for channels that record displacement (e.g., eye tracking), thus allowing you to create markers based on velocity.

• The Hilbert Transform may also be utilized as a method for marking time points on modulated signals (e.g., sound files or sine waves). Enable **Envelop (hilbert)** to display the envelope of the “analytic” signal.

**Step 4: Creating (Deleting) an event.**

• To add an event manually, click **Add Event**. This will place a red marker in the middle of the current time window, and given a number, latency and amplitude value located in the top right corner of the window.

• Drag and drop the new marker with your mouse to reposition the marker to its desired location.

• ! Warning Ensure that **the amplitude value label appears** at the top right corner of the window.

• To move other event markers (black lines), double click the desired marker until it becomes active (active markers will always be the colour red), and move where needed **until the amplitude value label appears** at the top right corner of the window.

• Delete specific markers by navigating to is using the **Previous/Next Event** buttons, or by simply double-clicking the desired marker until it becomes active (turns red). Take care that the marker label at the top of the screen is correct before proceeding. Click **Delete Event** to remove the current marker.

• Click **Clear Events** to remove all markers (loaded event file markers will not be removed).

• **Plot Data** will create a quick averaged figure of all the currently selected events for that channel. This will aid in deciding the accuracy of the marker placement.

**Step 5: Place event markers automatically (optional).**
• Events may also be placed automatically by using the Find Events feature. When using this feature, the dataset channel is scanned from left to right, and automatically marks the beginning of events based on the threshold duration, maximum/minimum amplitude range and minimum separation parameters you set in the Mark Events panel.

• Click Find Events. A black line will be placed at all latencies that meet your requirements.

• Readjust your parameters if needed (i.e., if not all onsets are detected accurately enough). Then simply rerun Find Events to overwrite your previous scan.

• Plot Data will create a quick averaged figure of all the currently selected events for that channel. This will aid in deciding the accuracy of the marker placement.

• To find the back-end of events (e.g., EMG offset), select the Reverse Scan checkbox before finding events.

• TIP: Zoom out when previewing your new markers to ensure that your parameters are appropriate enough to capture all events accurately and consistently.

Step 6: Create Events.

Once you are satisfied with your event markers, save your new event file in one of two ways:

1. Go to File → Save Event File... to save a custom text file (.txt) of all currently shown event latencies (i.e. all black markers).

2. Go to File → Save Event as Marker... to save the events directly into the MarkerFile.mrk file (*CTF datasets only). This option will prompt you for a marker event name. This event will now be recognized in Import MEG Data. Note that markers from the Marker dropdown menu (green markers) may also be saved as a text file, if needed. To do this, go to File → Save Marker as Text....
IMPORTANT NOTE ON IMPORTING DICOM FILES

- Prior to BrainWave version 3.0, conversion of DICOM MRI files to NIfTI format were done using the DICOM import feature of SPM8. These are now done using the MATLAB script dicom2nii available online at: http://www.mathworks.com/matlabcentral/fileexchange/42997-dicom-to-nifti-converter
- In all cases, NIfTI conversion scripts utilize any image orientation specified in the DICOM headers to ensure that the NIfTI header specifies any necessary spatial transformations required to read out the image data in standard RAS (right-anterior-superior) coordinates. As a result any subject rotation information detected in the DICOM headers will be interpreted by the NIfTI conversion routines as a need to correct or "rotate" the image to be in RAS orientation. This can result in an isotropically acquired MRI appearing to be non-isotropic after small rotational corrections. Although this should not affect the accuracy of such images, when acquiring isotropic MRI data, avoiding any small field-of-view corrections during acquisition will eliminate unnecessary interpolation of the MRI volume.
Step 1: Importing MRI data.

- MRI Viewer can be found in the main menu GUI.

- To import MRI files, go to File → Import MRI files… and navigate to the directory containing the original DICOM image files (e.g., .dcm or .ima) and select any image file within the directory. To open previously generated NIfTI (.nii) or native CTF (.mri) images, use File → Open MRI Files.…

- BrainWave will automatically load all dicom files within this directory.

- After file conversion into NIfTI format is complete, you will be prompted to provide a subject ID, which will automatically create a subjectID_MRI folder for this subject. A file called subjectID.nii will be saved within, then automatically loaded into the viewer.

**NOTE:** BrainWave is designed to work with isotropic MRI image data (ie. images with equal voxel size in all dimensions). The conversion into NIfTI will therefore include tri-linear interpolation of non-isotropic MRI data to be equal to the smallest voxel dimension. This will only be done if voxel size for any two dimensions differ by more than 0.01mm (≈ 2.56 mm maximum error over the entire field of view).

Step 2: Set Fiducials.

- Fiducial locations **must** be set for proper MEG to MRI co-registration.

- First, select the Edit checkbox to enable changes to fiducial locations.

- Use the interactive cross-hairs and/or scrollbars to bring a particular fiducial position into view, then click Set Nasion (or LE – left ear; or RE – right ear), and click Save Changes.

- **IMPORTANT:** If you change your fiducials after generating the shape file or headmodel file, you MUST recompute head models and re-save shape files (see Step#3 below for more details on shape files).

- **NOTE:** For added convenience, double-clicking a slice view will open an enlarged image to get the most accurate fiducial locations.
Additionally, a brightness bar has also been added to improve dark-to-light contrast.

- **Undo Changes** will reset the fiducials to the last saved positions.
- Each **View** button will navigate the image cross-hairs to the respective fiducial position.

### Step 3: Extract Surfaces For Spherical Head Models.

- **IMPORTANT:** FSL is required for the following process. Be sure that FSL has been added to your MATLAB path before continuing. Please see our online installation guide for more information on how to do this.

- Go to **Segmentation → Extract Surfaces Using FSL.**

- You may be prompted at this time to locate a T2-image (see section *MRI Viewer/Head Models OPTION: Using T1 and T2 images for improved surface extraction*) for more information on how to use T2 images for better surface extractions.

- This process will take several minutes to run. Once complete, you will be prompted to select a default head shape file (one of either: inner skull, outer skull or outer skin). For MEG source analysis, the **inner skull surface** is generally recommended for fitting spherical models.

- Saving as ‘default’ (subjectID.shape), it will be automatically superimposed onto the MRI.

- **If the skull surface(s) are generated inaccurately, it may be useful to load one of the other surfaces to be utilized for fitting the spherical model(s) instead.**

- To do this, go to **Segmentation → Load FSL Surface...**, then save the mesh file as a shape file: **Segmentation → Save FSL Surface as Shape...**

- Finally, load your new shape file: Go to **Head Models → Load Shape File...**

- (Option) Go to **Options → Display Options...** to make customized adjustments to the extracted point sizes. Tail length and thickness will allow adjustments to the size of each when viewing optionally imported dipole files.
NOTE: To be clear, MRIViewer distinguishes between “surface” and “shape” files. Surface files are triangulated meshes relative to the MRI volume coordinate system, but are independent of the fiducial placements. The Shape files consist of a list of surface points defined by the MEG coordinate system, and therefore dependant on the placement of fiducials. Surface mesh files must be first saved as a shape file in order to use it for computing head models as the spherical model needs to be defined in MEG coordinates. Thus, if you change your fiducials after generating the shape file or headmodel file, it is necessary to recompute head models and re-save shape files (see Step#2 for more details on how to compute head models).

Step 4: Create Single- and Multi-Sphere Head Models.

- Ensure that the *.shape file is loaded (see loaded images listed at the top of the window), then go to **Head Models → Create (single-sphere OR multi-sphere) Headmodel** (where multisphere models will prompt for a patch size).

- (Multi-)select each of that subject’s epoched datasets and name the head model (.hdm) file. Default filename is singleSphere.hdm.

- **NOTE:** If a group analysis is to be performed, it is important that the chosen head model name be the **same for each subject**.

- **NOTE:** Spherical models may also be performed when MRI images are not available, but other head shape information is available such as head shapes created using a Polhemus device). See the surrogate MRI section for more information on the use of Polhemus shape files in lieu of MRI images for spatial normalization.

Step 5: Importing Cortical Meshes from CIVET or Freesurfer (optional)

- **NOTE:** High resolution, three-dimensional cortical surfaces can be extracted using third party software. Currently, cortical meshes created using CIVET\(^2\) and Freesurfer\(^3\) are supported. If available, beamformer results may be optionally computed directly on these 3D surfaces.

\(^3\) [https://surfer.nmr.mgh.harvard.edu/fswiki/FreeSurferWiki](https://surfer.nmr.mgh.harvard.edu/fswiki/FreeSurferWiki)
Appendix 4 of this documentation holds more information on these file types.

- Warning If using demonstration datasets from our website (https://figshare.com/s/2e1c6559cadae29429bc), CIVET surfaces have already been extracted. Go to step 6 in this case. Otherwise, custom CIVET surfaces will require the following preparations.

- Ensure that the entire extracted CIVET or FreeSurfer folders (see Appendix 4) saved within the subject’s MRI folder. If original extraction folder structure is not found, BrainWave will prompt you for the location of the transform .xfm file (ie. in the CIVET “surface” folder or FreeSurfer “transforms/linear” folder). Otherwise, this file will be automatically found as long as the original CIVET or Freesurfer extraction file organization was preserved.

- Open a subject’s MRI into MRIViewer, and set fiducials (if not already done).

- Go to Segmentation → Import Cortical Meshes.... The prompt window will ask for the LEFT hemisphere surfaces first. Navigate to and select your LEFT hemisphere surface (e.g., lh.pial, *_surface_rsl_left_81920.obj) and click Open.

- You'll be immediately prompted again – this time for the RIGHT hemisphere surface (e.g., rh.pial, *_surface_rsl_right_81920.obj), click Open.

- TIP: To view only one of the hemispheres, simply click CANCEL when prompted for the unwanted hemisphere. For example, if you want to view only the right hemisphere, click CANCEL when it prompts for the left hemisphere, then select the right hemisphere when prompted.

- Note for CIVET Files: There will be multiple extracted surfaces saved in the CIVET folder. If available, it is recommended to use the resampled CIVET surfaces. This is important in the calculation of the group averaged surfaces as it will ensure all surfaces align correctly. The resampled surfaces are saved in the mesh files that have “_rsl_” in the filename (e.g., *_surface_rsl_right_81920.obj).

- Loading the surfaces may take a few moments. The loaded surface file will overlay the MR image. Examine to ensure that the file correctly aligns with the subject’s MRI.
BrainWave v3.5

- Warning: Misalignment could be due to loading an incorrect file (ensure that the correct subject files have been loaded) or fiducials have not been set.

- Once satisfied that the surfaces are correct and properly aligned, go to Segmentation → Save Mesh Hull as shape... and name the file (e.g., civet_mid_SURFACE.mat).

- Warning: Ensure that the filename ends with _SURFACE.mat prior to saving.

- This file may now be used in single subject as well as group image analyses as an Image Type option. See Single Subject Analysis or Group Image Analysis for more information on beamforming with 3D surfaces.
OPTION: Using T1 and T2 Images for Improved Surface Extraction

- ! This option utilizes the FSL brain extraction tool (BET) “–A2” feature. It carries out a standard co-registration of the T2 to the T1 image, which helps to further optimize brain and skull surface extractions. The –A2 option in FSL does take a fair bit longer to run.

Step 1: Save a T1-image
- Import your subject’s MRI as usual (see MRI Viewer/Head Models section for more details on this).
- Set the fiducial locations (if not already done).

Step 2: Save a T2-image
- Go to File --> Import MRI... and select the subject’s T2 MRI in the same way that you would the T1.
- Save it as a <subjectID>_T2_MRI folder by simply adding _T2 (underscore T2) after the subject ID (e.g. 001_T2).
- ! DO NOT OVERWRITE the T1 <subjectID>_MRI folder. Ensure the file reads <subjectID>_T2_MRI.
- You DO NOT need to set fiducials for a T2-image.

Step 3: Extract T1-image surface with T2-image
- Re-load the T1-image (go to File --> Open MRI), and navigate to the T1 image (e.g., 001_MRI / 001.nii).
- Select the “Extract Surfaces using FSL” option from the Segmentation dropdown menu.
- A pop-up will appear prompting you to select the matching T2-image. If you select NO, the T1-image will be extracted as before. If you select YES, BrainWave will use T2 to improve surface extraction.
- Click YES, and navigate to the T2 NIfTi image file you’ve created (e.g., 001_T2_MRI / 001_T2.nii). You should now get a message
within the command window that states that FSL is running with the –A2 option.

- Proceed with head model calculations as usual. Go to Head Models \rightarrow Create (single-sphere OR multi-sphere) Headmodel (where multisphere models will prompt for a patch size), then (multi-)select each of that subject's epoched datasets and name the .hdm file. Default filename is singleSphere.hdm.
OPTION: Alternative Head Model Calculation – Extract “Surface Hull” from CIVET/Freesurfer Surfaces

• If desired (or necessary if FSL extractions are not sufficient), one may now choose to calculate head models (single- and multi-sphere) by creating a surface “hull” using extracted CIVET or FreeSurfer files instead of FSL extracted surfaces.

Step 1: Organize folders

• Ensure that the entire extracted CIVET or FreeSurfer folders (see Appendix 4) saved within the subject’s MRI folder.

• If original extraction folder structure is not found, BrainWave will prompt you for the location of the transform .xfm file (ie. in the CIVET “surface” folder or FreeSurfer “transforms/linear” folder).

• Otherwise, this file will be automatically found as long as the original CIVET or Freesurfer extraction file organization was preserved.

Step 2: Open MRI

• Open or Import your subject’s MRI.

• Set the fiducial location (if not already done).

Step 3: Import CIVET/FreeSurfer Cortical Mesh

• Go to Segmentation -> Import Cortical Meshes, navigate to the subject’s surfaces (CIVET) or surf (FreeSurfer) folder and import the meshes as usual (see MRIViewer/Head Models section of this tutorial for details).

Step 4: Save a Hull Surface Shape (*.brainHull.shape) file

• Go to Segmentation -> Save Mesh Hull as shape….

• Load the file on to the MRI (Head Models -> Load Shape File…).

Step 5: Create Single- and Multi-Sphere Head Models.
BrainWave v3.5

- Be sure that the *brainHull.shape file is loaded (see loaded files named at the top of the window)

- Then go to Head Models \(\rightarrow\) Create (single-sphere OR multi-sphere) Headmodel (where multisphere models will prompt for a patch size), then (multi-)select each of that subject’s epoched datasets and name the .hdm file. Default filename is singleSphere.hdm.
OPTION: Utilizing “Surrogate” MRIs: Warping Template MRIs to Subject Surface Files.

- **In cases where you do not have an MRI**, but other head shape information is available to you, such as a digitized scalp surface (e.g., using a Polhemus digitizer), that sufficiently covers the entire scalp surface, it is possible to utilize a standard (or custom) “surrogate” template MRIs for the purpose of estimating approximate anatomical labeling of source activations and group averaging.

- **IMPORTANT NOTE ON SURROGATE MRIs**: The new warped “surrogate” MRI generated here, can only be as good as the shape file it is warped to. **Large spaces between shape file points can create distortions in the final surrogate MR representation.** This may ultimately reduce the accuracy of the source localizations performed later on. It is also important to remember that warping is based on only the **scalp surface**. Thus, the alignment of the subject’s individual brain structures to the template image will depend on many factors, including variations in skull thickness and brain morphology across individuals, and **should be considered only as an approximation** for the purpose of anatomical labeling and group analysis.

- A default **adult template MRI** (Colin-27 or CH2.nii) and a **pediatric template** (age 4-8 year old asymmetric, child_template.nii) has been provided for surrogate MRI warping (details regarding these templates can be found at [http://imaging.mrc-cbu.cam.ac.uk/imaging/MniTalairach](http://imaging.mrc-cbu.cam.ac.uk/imaging/MniTalairach) and [http://www.bic.mni.mcgill.ca/ServicesAtlases/NIHPD-obj1](http://www.bic.mni.mcgill.ca/ServicesAtlases/NIHPD-obj1), respectively). Default normalization option will use the standard SPM T1 template (ICBM152).

- Other **“custom” template MRIs may also be utilized** (e.g., age-specific NIH Pediatric Template database). To use a customized template here, simply place a copy of the custom MRI (.nii), as well as any associated tissue classification files (e.g., fiducial file [.mat], brain masks, etc.) in the *BrainWave* folder called **template** (bw_toolbox/template).

- **WARNING**: Although custom templates may provide a closer match between subjects (e.g., when using a template derived from a sample population, or a pediatric template when analyzing data from young
children), they may no longer correspond to standardized template space and their associated anatomical atlases. Thus, unless the template has been spatially normalized to the standard MNI template brain (ICBM152) the warped images will not necessarily correspond to standard coordinates in either MNI or Talairach space. You will receive a warning to this effect every time you select a custom template for group analysis.

**Step 1: Load a template MRI.**

- In MRI Viewer, go to **File → Open template MRI**.... The CH2.nii (and child_template.nii or other custom templates) template default fiducials have already been placed, but may be edited if necessary. Custom MRIs will require fiducial placement.

![Select template](image)

**Step 2: Load a Shape File.**

- Go to **Head Models → Load Shape File**... and select the head shape file of that subject. Files currently supported by *BrainWave*: CTF (.shape), Surface Point File (.sfp), GIfTI (.gii) or Polhemus (.pos).

- **WARNING:** *BrainWave* assumes that the digitized scalp surface is relative to the same fiducial locations that define the MEG sensor locations. If using shape data from other sources, you must first ensure that the shape data corresponds to standard CTF Head Coordinates, and is in **units of centimeters (cm)**.

**Step 3: Warp the template MRI to the shape file.**
• Go to Head Models → Warp template to head shape. This process may take several minutes to compute.

• Once complete, you will be prompted to save the newly warped template with the subject’s ID. This will generate the standard <subjectID>_MRI folder as the subject’s own MRI. Save this file within the folder that contains your epoched datasets for this subject.

Step 4: Process “surrogate” MRI for analysis.

• Prepare your new “surrogate” MRI for analysis as any other MRI by following FSL cortical extraction and spherical model calculations as described in the MRI Viewer/Head Models section above.

Step 5: Prepare for Beamformer Analysis (for Spatial Normalization and Group Averaging)

• Open your Single Subject Analysis or Group Analysis windows from the Main Menu GUI, and begin to load your datasets, set parameters and choose your analyses as usual (see Single Subject Analyses and Group Analyses sections of this documentation for more details).

• If you used the DEFAULT ADULT (OR PEDIATRIC) MRI, you are now able to continue the analysis process as if the MRI were the subject’s own anatomical image.

• If you used a CUSTOM MRI, you will also need to prepare the following:

  1. Select Template

     • Open Image Options in the Image Type panel of single or group analyses windows.

     • In this window, select the Use Custom Template radio in the SPM Options panel

     • Click Select to navigate to your custom MRI image (in the template folder of BrainWave).

  2. Select a brain mask (optional)

     • During the calculation of linear and non-linear warping parameters in SPM8, a brain mask can be used to aid in the co-registration and normalization process.
If the custom template includes a brain mask, and you have placed a copy of that mask in the template MRI directory, click Select (located in the SPM Options panels of the Image Options window, called Mask File) to navigate to your custom MRI’s brain mask file.

- If this field is left blank, SPM8 spatial normalization will proceed, but will be done using default parameters without a brain mask (*please consult the SPM8 documentation for further details).

**Step 6: Run Beamformer Analysis**

- You are now able to continue the analysis process as if the MRI were the subject’s own anatomical image. Click Generate Images.

**IMPORTANT:** A unique normalization file (*sn3d.mat) is created for each template used (as indicated by the template name utilized in naming this file). Spatial normalization calculation parameters will be saved in a `<template-file-name>_sn3d.mat` file, and is created the first time normalization is performed. It’s used for all subsequent warping to template space. **If any changes are made** to the MRI processing after this file is created (e.g., fiducial positions are changed, you want to use a different [or custom] MRI template, or you want to add a brain mask [see brain mask description below]), **you must delete any *sn3d.mat files of the same name** that exist in the subject MRI directory first.
Step 1: Select a dataset

- Open Single Subject Analysis from the Main Menu GUI. Click the Change Dir button and navigate to the folder that contains your subject’s epoched datasets (i.e., do not select the datasets). You should now see the list of your datasets appear in the Data Directory list box.

- Select the dataset you’d like to analyze. To the right of the directory box, you should now see the name of the dataset along with some details about it, such as the number of trials, sample rate and trial duration.

Step 2: Check Dataset Integrity (optional)

- ! Plot Average has been added as a useful tool to view the averaged sensor waveform data to confirm the presence of evoked responses, or simply detect the presence of any large artifacts. The
window allows you to adjust and preview the use of alternative bandpass filters and baselines.

• Click **Plot Average** to begin. This may take a few moments, and will display the mean sensor plot of the selected (highlighted) dataset.

• Move the cursor (a vertical red line) to view topographic map (bottom right circle) changes at particular points in time.

• At any point, click the **Add Map Latency** button in **Single Subject Analysis** window to generate a beamformed image at this latency.

• The **BrainWave Dropdown** menu provides various viewing options, including **individual channels**, the **global field power** or **all channels** (butterfly plot).

**Step 3: Setting Data Parameters**

• Select the **Data Parameters** button near the top right of the window.

• Choose the parameters you would like to use (see **Data Parameters** description in the **Program Navigation** section for more details), namely bandpass filtering, baseline correction, covariance window and headmodel selection, then hit **Save**. All initial parameters listed are default parameters. Any changes you make can always be reset back to these initial values by selecting **Set to Default** button.
Step 4: Specify Image Volume Resolution and Size (optional)

- Select the Image Options button within the Image Type panel near the bottom of the window, and customize your image options within the Image Volume panel.

- The default image volume resolution (step size) and size (bounding box) values are sufficient for most beamformer calculations (see Appendix 1 for mathematical details of beamformer computation), but may be adjusted if necessary.

- Click Save

- **NOTE**: Changes here will only apply to the volumetric image, and not virtual sensor calculations.

Step 5: Apply a brain mask (optional)

- **NOTE**: The ability to remove all activity from outside the brain may be done using a brain mask.

- Click the Image Options button, and enable the Apply Brain Mask checkbox within the Image Volume panel.

- Click Select, and then choose the brain mask you’d like to apply (default is *bet_inskull_mask.nii, but you may select *.nii from the file types dropdown in this window to select another mask file).

- Click Save.

Step 6: Choose a Beamformer

a. Event-Related Beamformer (ERB)
• ERB beamformers will compute rectified images of the instantaneous source power averaged over trials (i.e., time-locked to an event), and can be used to image activity associated with phase locked brain activity (i.e., evoked fields).

• Set the **Latency Range** of interest. This will generate an ERB image every step size number of seconds (default step size = 5ms, or 0.005s) across a specified time window (start and end time required, in seconds).

• Alternatively, add latency values of interest to the **Latency List**. These latencies may be read from a simple text (.txt) or CTF marker file (.mrk) (by selecting the **Read from File** button), written directly into the latency list box, or selected from the cursor location in the **Plot Average** window by first placing the red line cursor to a time of interest, then clicking the **Add Map Latency** in the Single Subject Analysis window (see **Check Dataset Integrity** step above for more details). The latency list can be entered in any order, as the resulting image set will re-order the images in correct temporal order.

• The **Use different covariance dataset** option is also available for cases where one might use another dataset’s covariance matrix for calculation of the beamformer weights.

• You may also opt to generate a single averaged image from all of the computed images by selecting the **compute mean** checkbox.

b. **Synthetic Aperture Magnetometry (SAM)**

• SAM images will generate images of source power summed over individual trials and is thus well suited for imaging induced brain responses over narrow frequency ranges (although the image will contain both stimulus phase-locked and non-phase-locked power changes).

• Select a SAM image type (see Appendix 1 for how these different metrics are computed):
  • **Pseudo-Z**, when given a single time window (start and end time, in seconds), will generate the source power summed over the length of the time window.
• **Pseudo-T** is the most common method, and generates a difference (subtraction) of the source power in the baseline from the source power in the active time windows selected.

• **Pseudo-F** will generate the ratio of source power between the two time windows (active over baseline).

• There is an additional option to utilize the baseline windows from alternate datasets from the same subjects, where applicable, by selecting the **Use different baseline data checkbox** and navigating to the dataset. This provides the option to compute a difference image (pseudo-T or pseudo-F) between time windows from two different conditions, or from the same condition but time-locked to different events.

• Choose your time windows of interest (**Active Window** versus **Baseline Window**), the size of the “sliding window” shift across time (**Step Size**), and the number of “sliding window” steps to get there (**No. Steps**).

• **NOTE ON USING A DIFFERENT BASELINE DATASET**

  Datasets do not have to have identical trial durations or numbers of trials, but should be the same in all other respects (same subject, head position, number of MEG sensors etc) and will work best if the data from each dataset was not recorded at very different points in time (i.e., trials are interleaved).

**Step 7: Select an Image Type**

• Choose one of three image options in the **Image Type** panel at the bottom of the window:

  3. **MEG Coordinates**

  • Generate a 2-dimensional glass brain volume image, illustrating the calculated peaks within the native CTF coordinate system.

  4. **MNI Coordinates**

  • This coordinate system will require the subject MRI to normalize the beamformer into Talairach space using SPM8.

  • Additional setup may be required if a customized surrogate MRI was used (see **MRI Viewer/Head Models** section for more details on this)
5. Surface

• If available, the use of CIVET or FreeSurfer extracted cortical brain surfaces will enable the use of surface-based beamforming.

• Select Surface radio button

• Click Select to load to your saved surface file (*.SURFACE.mat, e.g., civet_mid_SURFACE.mat) created after importing these cortical meshes onto the MRI (see MRI Viewer/Head Models section for more details).

• Click View to preview and ensure that BrainWave is able to read the mesh.

• Optionally, you may also set Image Options to calculate normal surface constraints, and/or compute non-rectified ERB images for the surface beamformers only. The Surface Image dropdown includes the option to save the images in the older Freesurfer overlay file (.w) format. Note that these images are not used by BrainWave and this feature is provided for test purposes only. Also if this option is chosen you will not be able to view the images in BrainWave. A plain text file of the voxel values will otherwise be saved by default. Click Save to keep any image option changes.
Step 8: Generate Beamformed Images

- Once all parameters, beamformers and image options have been set, click Generate Images.

- Under File, select Save Images... for volumetric images (or Save Imageset... for surface images).

- Generated images do not save automatically. You must save images in order to reopen them later.

- Give the image a name and save to the current directory only. A new folder will be created, and image sets (named <dsName>_VOLUMETRIC IMAGES.mat or <dsName>_SURFACE IMAGES.mat respectively) will be filed within them. See Program Navigation section for details on how to navigate these generated images.

Step 9: Generate Virtual Sensor and TFR Plots ...

a. ...From Volumetric Images

- Select the Show Peaks checkbox from the generated image. A list of peak(s) for the current latency time window and threshold will appear in order from strongest to weakest.

- Click on a peak from the list. Blue cross-hairs will overlay the image to show the location of the peak.

- Click the (now enabled) Plot VS button located beneath the list of peaks.

- From within this pop-up window (see Program Navigation: Group VS Analysis section for detailed information on this window’s features) the time-course (VS) can be computed from the voxel location listed.

- The data processing parameters used to generate new weights for the selected voxel (e.g., bandpass, covariance window settings etc..) will automatically be set to what was used to generate the image. However, these can be changed by upon selecting the Data Parameters button. E.g., a different bandpass can be selected. However, this may result in changes in source orientation etc.
• Click **Plot VS** or **Plot TFR** for a VS or TFR plot representative of the currently selected peak. See *Program Navigation: The Virtual Sensor (VS) Plot* and *Program Navigation: The Time-Frequency Representation (TFR) Plot* for more information on their features.

• As you move through the latency windows, you may also collect multiple peak locations for later virtual sensor analysis, or for statistical testing in an external spreadsheet program. To do this, highlight a peak, then click **Add peak to list**. A virtual sensor list window will appear and append all selected peaks to this window. When you are finished collecting peaks, go to **File → Save Voxel list...** to save the .vs file.

![Plot VS and TFR](image)

b. **…From 3-D Surface Images**

• **Rotate, zoom** and/or **pan** the image to find a peak of interest at a chosen latency.

• Enable **View Inflated** for a better view of peaks occurring deep in the sulci.

• Enable the **Cursor** radio in the left column, and click directly on the peak (brain surface).

• Alternatively, click the **Find Peak** button to let BrainWave generate a list of the strongest peaks within the current latency window. Click each peak on the generated list to view where on the brain it is located.

• Click **Plot VS** (located at the bottom right side of the screen). See *Program Navigation: Group VS Analysis* section for detailed information on this window’s features.
OPTION: Render Subject Volumetric Image onto 3D Adult Template Surface (CH2)

- You may now preview 3D rendered volumetric (glass-brain) data onto our built-in extraction of the adult template (Colin-27 or CH2.nii) without the need for CIVET or FreeSurfer extracted surfaces. In this method, data is interpolated, using a trilinear interpolation routine, to map non-thresholded image data onto the template surface.

- All functionalities are accessible, however peaks must **NOT** be taken as true. **This feature is intended for estimation and previewing purposes only, and not as a substitute for a subject’s own unique extraction(s).**

- For the best estimations, warp the template to approximately fit the shape of each individual subject:

  **Step 1: Load a subject MRI.**
  - In *MRI Viewer*, go to File -> Open MRI file…
  - Select a individual subject’s MRI (.nii) file.

  **Step 2: Load Template Extracted Surface.**
  - Go to **Segmentation** and select **Create Template Mesh**. This step will take a few minutes to warp the template surface into the individual’s MRI space using SPM and the subject’s own resliced MRI (.mat) file.
  - The template surface (red dots) should now align well with the anatomy of the subject’s MRI.
  - A file *ch2_template_SURFACE.mat* will be automatically saved within their MRI folder.

  **Step 3: Load surface file for single subject or group analyses.**
  - Prior to generating an image, select *ch2_template_SURFACE.mat* from the *Image Type* surface option.

  **Step 4: Repeat above steps for all subjects.**
BrainWave v3.5

- BrainWave will use the generic CH2 template surface in template_MRI if it is a group averaged image, otherwise it will search for the ch2_template_SURFACE.mat file inside the subject’s own MRI directory.

- For testing purposes only, you may alternatively interpolate the data from a particular time point of the glass brain onto an unwarped adult template brain:

  **Step 1:** Generate image in MNI space (either single subject or group)
  - The plot 3D feature will not work with CTF coordinate space.

  **Step 2:** Navigate to latency of interest.

  **Step 3:** Plot 3D image
  - Click the now-enabled **Plot 3D** button. BrainWave will interpolate the current latency’s data onto the unwarped template 3D surface.
Step 1: Open Group Image Analysis from the Main Menu GUI.

Step 2: Create a new study

- Go to File → New Study… Give your study a name and save it.

  - IMPORTANT: Ensure that the filename ends with _STUDY (underscore “study” in capitol letters).

Step 3: Add Conditions

- Go to File → Add Condition… and multi-select all subject condition files you’d like to include for group analysis.

  - Enter the name of the condition in the pop-up window.

  - Repeat for all conditions that you would like to test.

  - Each condition will now appear in both Condition dropdown menus.

  - Use the +/- buttons to add/delete datasets from the list(s).

Step 4: Choose Comparison Type.

- Single condition group analyses
To generate a simple group averaged image for a single condition, select a **condition** from the **Condition 1** (or from **Condition 2**, if enabled) dropdown menu.

**Proceed to step 5.**

**Multi-condition group analyses**

⚠️ Contrast images, or a customized calculation of beamformer weights can be generated when multiple conditions are present.

1. **Contrast Image.**
   - Select a condition list for Condition 1 from the **Condition 1** dropdown menu, and for Condition 2 from dropdown menu 2.
   - From the *Generate Images for:* list in the middle of the window, select **Condition 1 minus Condition 2**.
   - From the *Compute beamformer weights using:* list, ensure that **Each Condition Separately** is selected.
   - **Proceed to step 5.**
   - ⚠️ The resulting image will be a simple difference contrast image between the two conditions’ averaged beamformers.

2. **Specify Method for Computing Beamformer Weights.**
   - ⚠️ In cases where a greater signal to noise is needed, calculating the weights from related datasets may provide a useful solution.
   - With Condition 1 and Condition 2 loaded using the condition dropdown menus, select the **Condition 1** option under *Generate Images for.*
   - Select your weight calculation:
     a. When making contrasts, the weights can be based on the covariance data for each given condition (**Each Condition Separately** option) in which case the weights may differ for the same voxel across...
conditions (e.g., due to different SNR, number of trials or noise).

b. To ensure that images are not biased by these difference in weights, you may select the “Common Weights” condition (Conditions 1 and 2) which will combine all trials for each condition into one combined dataset which will be used as the covariance data for all further calculations (both images and virtual sensors).4

c. Finally a third option is available to manually specify an alternate covariance dataset (Covariance Condition). For example this could be the combination of all conditions in a factorial design study, or even the continuous data prior to epoching, with the restriction that the channel set and subject ID order must match the other conditions.

- Proceed to step 5.

Step 5: Choose Beamformer, Set Parameters and Choose Image Type

4 Note on covariance selection and comparing multiple conditions. For the scalar beamformer images and virtual sensors, the covariance data determines both the weights and forward solution that corresponds to the optimal source angle. Both will influence the scaling of source amplitude at that voxel location. Thus, even if using pseudo-Z units for virtual sensors, differences in the selected angle can result in biased estimates of amplitude between conditions. Furthermore, comparisons of virtual sensor (VS) amplitudes should always be done in units of moment rather than pseudo-Z, since when using units of pseudo-Z the VS amplitude may scale differently due to differences in SNR (e.g., if one or more conditions has a small number of trials). In the case of VS in units of moment, if the optimized angles are the same across conditions the comparison of source amplitudes should be unbiased. Using common weights however, will essentially fix the source orientation between conditions ensuring this, even if the SNR is comparable between conditions. It should be kept in mind however, that when using common weights, if the two datasets contain very large differences in head position, or large artifacts, this could result in suboptimal weight estimates for both conditions.
Step 6: Save your Study.

- Go to File → Save Study. All parameters, conditions and other options will be saved together in the *_STUDY.mat file.

- It is important that you save before closing this window. Not saving your study will result in errors when trying to reopen the study later on.

Step 7: Generate Group Images

- Once all parameters are set, click Generate Group Images.

- A save window will appear. Type in a group image name.

- **TIP:** Do not use spaces or dashes in the name, and keep name as short as possible (e.g., healthy_group) to avoid read/write errors later.

- Depending on the calculations selected, this will take several minutes to complete. Once compete, an averaged normalized image (or surface based beamformer, in the case of the surface rendered display option) will be displayed.

- The Data dropdown menu will allow you to navigate each subject's NIfTI image used for the normalization process.

Step 8: Generate Virtual Sensor and TFR Plots

Step 9: Image Permutation Analysis

- In the group image, go to Data, and select **Permute Images**.

- A pop-up window will display options for significance value (alpha, p-value), number of permutations.

- The permutation distribution plot may optionally be selected before running the test by clicking the **Plot Distribution** checkbox (only available for the omnibus test).

- Choose between the two tests provided to generate statistically thresholded images from group data: **Corrected (omnibus)** and **Uncorrected (voxelwise)**. See **Program Navigation: Group Volumetric Images** for more details on each.

- The resulting permuted image has options to **Plot VS** or **Add peak to list** just like the original. See **Tutorial: Group VS Analysis**, and **Program Navigation: Group VS Analysis** section for detailed descriptions.
Group Virtual Sensor (VS) Analysis

- ! This feature is compatible with older BrainWave .vlist files. However, you must first navigate to correct directory containing the older datasets.

Step 1: Open Group VS Analysis from the Main Menu GUI.

Step 2: Open files.

- Go to File --> Load Voxel List... Select a saved voxel location list (*.vlist) file. This may be a file created by saving multiple peaks of interest (see Add peak to list in single subject and group image analyses sections) or older BrainWave version lists.
- The list will appear in the box on the right side of the window in the Virtual Sensor Parameters panel.

Step 3: Set Options.

- Set your Data Parameters, optional VS or TFR options as needed.

- ! Refer to Program Navigation: Group VS Analysis, Group Image Analysis & Single Subject Image Analysis sections for more details on these options and more.
**Step 4: Plot group virtual sensor or TFR.**

- Click **Plot VS** to generate a group virtual sensor or **Plot TFR** group time-frequency representation plot.

**Step 5: Plot single subject virtual sensor or TFR.**

- **⚠️** You may also generate a single subject VS or TFR plot, as needed.
- To do this, simply click on (highlight) a dataset in the virtual sensor list
- Ensure that **Plot Selected Only** checkbox is selected in the *Virtual Sensor Parameters* panel.
- Set parameters as usual (using **Data Parameters**).
- Click **Plot VS** or **Plot TFR**.

![Virtual Sensor and TFR plots](image)
Archive: Average/Permute Images

**IMPORTANT NOTE**: This feature has been kept for backwards compatibility only (BrainWave versions < 3.0). Group VS and TFR plots as well as permutations statistics, may now be generated directly from the group images, as described in the Group Image Analysis section above.

**Step 1: Open the Average/Permute Images window from the Main Menu GUI.**

- In Main Menu GUI, go to Tools --> Average/Permute Volumes...

**Step 2: Open pre-computed beamformer images.**

- Files used here must be normalized NIfTI (w*.nii) image format.
- Click the Add File(s) button (located above the Condition A and B panels) to add NIfTI files individually.
- Alternatively, the Read List button allows the import of a previously saved group *_wimage.list file.
- Repeat for Condition B, if required. To enable this window, click the Create Contrast Images checkbox at the top of the window.

**Step 3: Set Options.**

- The number of permutations (No. of Permutations) will be set automatically to the maximum but may be adjusted to a lower value if desired.

- The number of permutations cannot exceed the value of 2N, where N = the number of subjects. The default is 2048 permutations, or less if the group contains fewer than 11 subjects. If desired a greater number of permutations can be selected up to the maximum, with a corresponding increase in computation time.

- Set statistical significance (alpha). By default, this is set to 0.05, but may be lowered to a minimum alpha of one bin size which is = 1.0 / number of permutations.

- If necessary (e.g., to eliminate large artifacts that may bias the permutations), select Use ROI (MNI coords in mm): and set your
bounding box accordingly. For example, to look only at the left hemisphere, change the values of X (from -75 to 70) to (-75 to 0). For details on the ROI approach, see Chau et al., 2004.

- **IMPORTANT:** The ROI bounding box should be used judiciously to avoid false positives. Refer to the footnote on permutation in this section.

**Step 4: Create Contrast Image (Optional).**

- Select **Create Contrast** checkbox to open the *Condition B* section of the window.

- Set up the image list and parameter options as described above.

- **IMPORTANT:** Images must be in the exact order within each condition list for a proper contrast image can be generated. Each image will then create an averaged .nii image labeled by this subject order. For example:

  - `subj_1_wimage,cw_-4_1.8,1-30Hz_time=0.050-wimage,cw_-4_1.9984,1-30Hz_time=0.050.nii`

- **IMPORTANT:** The resulting image created will be the averaged (or significant averaged and permutation distribution) images, where *Condition B* is subtracted from *Condition A*.

**Step 5: Generate Images.**

- **Average Only.**

  - By pressing the **Average** button, a normalized group image with the ROI values set will be generated. It will first prompt selection of the original group Imageset for which the chosen image files were originally generated. This original Imageset will be used for **Add peak to list** and **Plot VS** functions when a peak is selected from the normalized image. Clicking **cancel** on this window will skip this step, in which case the **Add peak to list** and **Plot VS** options will not be available in the new image.

  - A second window will appear for inputting a group image name. If the original Imageset was identified in the previous step, the new image’s name will be prefixed by the original Imageset name.

  - **No permutation will be done**, and the image will be identical to the image generated using **Group Image Analysis**

- **Permute and Average.**
• Pressing the **Permute and Average** button will prompt selection of the original group Imageset followed by a save window.

• Input a group name.

• An omnibus permutation\(^5\) analysis will be run on the images, and generate a normalized group average.

• If any peaks are found to be significant, the significant thresholded (alpha) normalized image and corresponding **permutation distribution** figure will also appear.

• The vertical red line in this latter histogram plot represents the significant peak magnitude value.

---

\(^5\) Each step of the permutation involves randomly flipping the polarity of all voxels in the image and computing the mean image. The maximum value in the image is then placed in the permutation distribution. The value corresponding to the area under the permutation distribution for the chosen Type I error level (alpha) can be used as an omnibus threshold for the entire image. This avoids correcting for multiple comparisons. This has the disadvantage of being biased by the largest activation in the image when multiple peaks are present. This can be a common problem due to the non-uniformity of the SNR within the beamformer images. An ROI analysis bounding box can be used to exclude brain regions in cases where large artifacts may obscure otherwise significant brain activity (Chau et al., 2004).
This section will describe each feature and option within BrainWave, including all dropdown menu options. Additional information about each can be found in the tutorial section.
Navigating The Main Menu

Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Study</td>
<td>Open previously saved study with all saved parameters (*_STUDY.mat).</td>
</tr>
<tr>
<td>Open ImageSet</td>
<td>Open previously saved volumetric (<em>_VOLUME_IMAGES.mat) and surface (</em>_SURFACE_IMAGES.mat) image sets.</td>
</tr>
<tr>
<td>Open VS plot</td>
<td>Open previously saved virtual sensor plots (*.mat)</td>
</tr>
<tr>
<td>Open TFR plot</td>
<td>Open previously saved time frequency representation plots (*.mat)</td>
</tr>
<tr>
<td>About BrainWave</td>
<td>Information about the current BrainWave version, including citation references list</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average/Permute Volumes</td>
<td>Tool used for performing permutation statistics on current (and older) BrainWave version files. See Average/Permute tutorials below on use.</td>
</tr>
<tr>
<td>Combine CTF Datasets</td>
<td>Tool used for combining datasets into one. Only available for CTF format datasets.</td>
</tr>
</tbody>
</table>

Features Description

The BrainWave Main Menu GUI is a user-friendly, and designed to aid in a more streamlined method to preparing and analyzing MEG datasets.
1) Import MEG:

Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load CTF Datasets</td>
<td>Load a continuous (non-trialed) dataset for preparation. CTF datasets only.</td>
</tr>
<tr>
<td>Load Parameters</td>
<td>Load previously saved parameters, including all data parameter</td>
</tr>
<tr>
<td></td>
<td>settings, choice of filters, etc.</td>
</tr>
<tr>
<td>Import MEG Data</td>
<td>Import other MEG file types (Yokogawa, *.con, or Neuromag *.fif).</td>
</tr>
<tr>
<td>Save Parameters</td>
<td>Save all current set parameters. (*.mat)</td>
</tr>
<tr>
<td>Combine Datasets</td>
<td>Tool used for combining datasets into one. Only available for CTF format</td>
</tr>
<tr>
<td></td>
<td>datasets.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes current window</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Batch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open New Batch</td>
<td>Opens a time-saving tool to allow multiple datasets to be run sequentially</td>
</tr>
<tr>
<td></td>
<td>in queue. Once open, proceed creating datasets.</td>
</tr>
<tr>
<td>Close Batch</td>
<td>Closes batch. No more datasets may be added to the queue.</td>
</tr>
<tr>
<td>Run Batch</td>
<td>Starts the batch sequence in order.</td>
</tr>
<tr>
<td>Cancel Batch</td>
<td>When batch is closed, you may alternatively choose to cancel the batch</td>
</tr>
<tr>
<td></td>
<td>sequence.</td>
</tr>
</tbody>
</table>

Features Description
Data Parameters Panel.

The Data Parameters panel will display information (number of channels, bandpass, sampling rate, etc.) about the loaded continuous (or single trial) raw dataset. CTF fiducial locations, as well as whether continuous head localization (CHL) was used during the dataset collection, will also appear here. Currently, datasets must be of either Yokogawa (*.con), Neuromag (*.fif) or CTF (*.meg4) formats to be read by BrainWave.

Dataset (dropdown). Loading datasets may be done here by simply double-clicking the dropdown to pull up the import option. Currently, this feature works only for CTF dataset file formats. Yokogawa and Neuromag data must be imported via the File dropdown menu.

AutoFill: Subject ID. Will read the raw dataset name and automatically keep any instance before the first underscore as the participants ID. Anything before the first underscore of a dataset name is automatically used, but may be changed by deselecting the Subject ID checkbox. This field is mandatory.
**AutoFill: Run ID.** Auto selection of the run ID is read from the CTF’s Dataset ID field that is often customized at the time of acquisition. This field is not mandatory and may be deselected.

**AutoFill: Event Name.** Will append the name of the event marker used to perform the current epoch. This field is not mandatory and may be deselected.

**Label.** Further name customizations to the new dataset may be made in this box. It is important to note for Batched processes, that this field does not automatically update.

### Epoch Selection Panel.

**Single Epoch.** Select to look at a specific time window only (in seconds).

**Use Event File.** Load a text file of latency values using the Load Event File button. CTF marker files (*.mrk), Yokogawa event files (*.evt) or a customized list file of latencies in text format (*.txt) generated using **Create Events** (see below) may be imported. The list will appear in the Latencies scroll box. Deleted or latencies that do not match the epoch parameters, will be marked with double asterisks (**) in the Latencies scroll box. The **Delete Event** button will remove the selected event (latency) from analysis.

**Create Events.** Create events by manually placing event markers, or automatically find them within specific MEG channels using custom threshold parameters. See **Create Events section below for more details on how to use it.** (**At this time, only CTF datasets are compatible with this feature**).

**Epoch Window.** Select an epoch window size by setting Start and End times (in seconds). Setting a Minimum Separation (in seconds) value will ensure that each trial contains the correct type of information (e.g., a negative minimum separation value will allow event epoch windows to overlap by the amount assigned). Latency Correction (in seconds) has also been included to compensate for known time differences during an experimental test (e.g., frame rate differences between the stimulus computer and the projector) by shifting all trials by the assigned amount.

### Pre-Processing Panel.

**Filter Data.** Selecting a bandpass here will be set in the new dataset.

**Use Expanded Filter Window.** Enabled with filtering option. To avoid filtering edge effects, BrainWave will take 50% more of trial window to filter then remove the expanded window edges.
**Sample Rate.** Enabled with filtering option. Datasets can be downsampled by selecting an available value from the dropdown. To avoid aliasing, the sample rates available in the menu will correspond to rates that are greater than or equal to 3 times the currently specified low pass filter cutoff.

**Use mean head position.** This feature becomes enabled when CHL recordings were present during the scan. The fiducial locations reflect the initial head position measured by the MEG at the start of the scan. When enabled, this feature calculates the mean head position for all of the current epochs only. The new fiducial positions (reflecting the new mean head position) will be coloured red. Any changes to the epoch (trial window size, latency corrections added, filters added, etc.), BrainWave will need to re-compute the new mean head position. To re-compute, reselect the **Use mean Head Position** checkbox or press the **Update** button.

**Channel Selector.** Depending on the MEG system, Channel Selector may provide the option to display either gradiometer and/or magnetometer sensor locations. In the case of Elekta Neuromag - to CTF converted datasets, the option to save only magnetometer or gradiometer sensor data becomes enabled (see figure below), but not necessary for data analysis. Channels already saved to the dataset as “bad” during preprocessing with the CTF MEG4 software, will appear in the excluded column. These may be re-included into the **Included channels** column at any time. Go to **Tools → Rotate 3D** to rotate the sensor shape. Currently selected sensors from either list will highlight the sensor in **red**. Sensors turn **grey** when moved to the **Exclude channels (X)** column, where X is the number of channels excluded. These sensors will then be noted with double asterisks (**) in the MEG channel list in the **Import Data** window. The list of excluded channels can be saved by pressing **Save List** and choosing a name when prompted. This list can be deleted by pressing **Delete List**.
Epoch Rejection Panel.

All epoch rejections may be used at the same time or sequentially. Each may be applied to only certain channels by (multi-)selecting the channels to be excluded from the MEG channels list, then selecting the **Scan selected channels only** checkbox. To preview the rejected trials, press the **Scan Epochs** button. Rejected trials (and channels) will appear red in the preview, and labeled with a double asterisks (**) in the latency and MEG channel scroll lists. **Reset** will remove all rejection parameters and set all rejected trials back to its inclusive state.

**Exclude epoch if... peak-peak amplitude exceeds (X) picoTesla.** Trials containing large infrequent artifacts can be removed rapidly with this option. If a trial exceeds the selected peak-to-peak range, it will be excluded from the new dataset.

**Exclude epoch if... reset detected (amplitude step exceeds) (X) picoTesla.** Detects the large, sudden signal amplitude jumps often due to interference.

**Exclude epoch if... mean sensor motion exceeds (X) centimeters.** If **Use mean head position** is selected from within the *Data Parameters* panel, this option will become available. It will enable you to exclude any trial with a head position that is (X) centimeters away from the calculated **mean** head position.

**Exclude Channels where number of trials rejected exceeds (X) percent.** Determines whether a high percentage of trials are being rejected because of a particular problematic channel or group of channels. This option is only available if one of the other epoch rejections has been selected. If the number of rejected trials exceeds the percentage allowed, a pop-up will inform you of how many channels were the cause of the high rejection rate. Click **Edit Channels** to view which channels were the cause of the high rejection rate, and edit as necessary. **Ignore** will remove all without editing.

Preview Panel.

Preview all channels and trials by selecting each from the MEG channel and/or Latencies scroll windows. Multiple channels may be displayed at once. **Select all** will overlay all channels. **Remove offset** will remove the DC (mean) offset from each trial so that trials with large offsets are visible in the pre-view window. This offset removal is also applied during scanning for artifact rejection, This feature is important for detecting large DC shifts in the data without having to apply a high-pass filter to the data. Note that offset removal only applied during plotting / scanning and is
not applied to the data prior to saving the epoched data. **Show Bad Channels** will allow channels that were excluded (marked by **) to be seen in the preview window in red.

**Create Dataset.**

Optionally, you may also select **Save Average** and **De-Identify Data** checkboxes. The former will save an additional averaged dataset of the file you are generating. The latter removes a couple fields within the CTF header files that often contain subject identifying information. Once all epoching parameters are ready to go, **Create Dataset** then give your new dataset a name and navigate to the folder you would like to save the new dataset to. This will take several seconds to generate.
1) Import MEG: Create Events

⚠️ Available for CTF Format only.

Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Event File...</td>
<td>Loads latency file (either CTF Marker File, <em>.mrk, or custom text file,</em>.txt) as events (black vertical lines).</td>
</tr>
<tr>
<td>Save Event File...</td>
<td>Saves all new events into a latency (*.txt) file.</td>
</tr>
<tr>
<td>Save Event as Marker...</td>
<td>Appends all new events directly into the CTF MarkerFile.mrk file.</td>
</tr>
<tr>
<td>Save Marker as Text...</td>
<td>Saves all current markers (from the Marker dropdown menu) into latency text file (*.txt). (green vertical lines)</td>
</tr>
<tr>
<td>Use EMG Defaults</td>
<td>Make searching for EMG onsets easy by using some default parameters to get you started.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes current Event Marker window.</td>
</tr>
</tbody>
</table>

Features Description

![Event Marker Window]

- **Channel** and **Marker** are selected options for viewing specific data.
- **Data Parameters** include settings for threshold, scale, and low pass filter.
- **Mark Events** offer options for setting event thresholds and duration.
- **Marker dropdown menu** provides options for editing and managing markers.
Channel *(dropdown)*. All channels collected into the dataset at the time of the scan (e.g., all MEG channels, Head Coils, EMG, EEG, eyetracker, etc.) may be selected here.

Marker *(dropdown)*. Any event markers saved to *MarkerFile.mrk* will be listed here. A *green vertical line* will indicate a marker file event.

Data Parameters Panel.

⚠️ **NOTE**: Any changes applied here (e.g., filters, rectification, etc.) will NOT change the dataset. All changes here will be applied to the preview only. However, changes will influence of event marker placement and thus may affect the accuracy of marker placement.

**Scale Minimum/Maximum.** Adjust the amplitude gain of the channel manually, or by using the up/down arrows.

**Filter High Pass/Low Pass.** Apply bandpass filters to the channel.

**Epoch Duration.** Adjusts the duration of the preview window above. Increase to preview more of the dataset at once, or decrease to preview the channel in more detail.

**DC Offset.** Shift the channel to be displayed in the centre of the preview. To do this, set a value that roughly aligns to the mean amplitude across the entire dataset.

**60Hz.** A notch filter at the North American powerline frequency of 60Hz.

**Rectify.** Shifts all dataset values to one direction (e.g., all values will become positive values).

**Invert.** Flips all dataset values to its opposite direction (e.g., all positive values become negative and visa versa).

**Differentiate.** First-order differential is calculated across the entire dataset.

**Envelope (Hilbert).** Derives the amplitude envelope for each frequency bin after bandpass filtering the data about the center frequency.

**Mark Events (manually).**

New events may be added manually by using the *Add Event* button. A *black vertical line* will indicate all new markers. Currently selected
markers appear as red vertical lines and information about it will appear in the top right of the window. **Double click any new event (black line) to make it the current event (red line).** Events must be current (red) to delete (Delete Event button), or navigate using Previous Event and Next Event buttons.

**Mark Events (automatically).**

Find events automatically using the parameters set in the Mark Events panel. **Threshold** and **Maximum/Minimum Amplitude Range** values will respectively appear in red and green horizontal lines. **3.0 Std Dev.** will set the threshold to a value equal to 3 standard deviations from the mean amplitude computed over the entire trial. Set **Minimum Duration** and **Minimum Separation** values (in seconds) then click **Find Events** to scan the dataset for events that meet these criteria as it is scanned left to right. Select **Reverse Scan** to find events that meet these criteria as it is scanned right to left for back-end marking (e.g. EMG offset).

**Plot Data.**

An averaged epoch (default -2 to +2 seconds) will be plotted for the new events. This feature does NOT work for markers – only NEW events (black vertical lines). The **BrainWave** dropdown in this plot will allow you to **save the raw data for all event trials into a separate file (*.raw).** The plot may be previewed as an average, or as a single trial overlay – both options can be found in the **BrainWave** dropdown menu of the plot.
2) MRI Viewer/Head Models

Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open MRI File...</td>
<td>Load a previously saved .nii file.</td>
</tr>
<tr>
<td>Open Template MRI...</td>
<td>Load a template MRI to be used as a surrogate MRI.</td>
</tr>
<tr>
<td>Import MRI Files...</td>
<td>Import raw MRI DICOM (<em>.dcm or <em>.ima) files. Also import old NIfTI files (</em>.nii), CTF MRI files (</em>.mri). Each will be converted (and interpolated) into an isometric NIfTI image (*.nii).</td>
</tr>
<tr>
<td>Load SAM Overlay</td>
<td>Overlay BrainWave generated beamformer results onto an MRI. SAM image (positive or negative values) or event related images may be displayed (*.svl files only).</td>
</tr>
<tr>
<td>Load Dipole File...</td>
<td>Load a CTF DipoleFit generated file (*.dip)</td>
</tr>
<tr>
<td>Open Head Model</td>
<td>Load a previously generated single sphere or multi-sphere head model file (*.hdm).</td>
</tr>
<tr>
<td>Save MRI as...</td>
<td>Save current MRI as a new subjectID_MRI folder, or save as a CTF MRI format file (*.mri).</td>
</tr>
<tr>
<td>Close</td>
<td>Close MRI Viewer window.</td>
</tr>
</tbody>
</table>
### Head Models

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Shape File...</td>
<td>Load a CTF (<em>.shape) file, Surface Point File (</em>.spf), Polhemus (<em>.pos) or GIFTI file (</em>.gii).</td>
</tr>
<tr>
<td>Create single-sphere head model</td>
<td>Calculates single sphere head model.</td>
</tr>
<tr>
<td></td>
<td>*Requires loaded shape file and saved fiducial placement.</td>
</tr>
<tr>
<td>Create multi-sphere head model</td>
<td>Calculates multi-sphere head model.</td>
</tr>
<tr>
<td></td>
<td>*Requires loaded shape file and saved fiducial placement.</td>
</tr>
<tr>
<td>Save Head Model</td>
<td>Save current (single/multi-sphere) head model to multiple datasets.</td>
</tr>
<tr>
<td>Warp template to head shape</td>
<td>Calculates then shrinks MRI into best fit of surfaces points.</td>
</tr>
<tr>
<td></td>
<td>*Requires loaded shape file and saved fiducial placement.</td>
</tr>
</tbody>
</table>

### Segmentation

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extract surfaces using FSL</td>
<td>Cortical, inner skull and skin surface meshes are extracted by FSL. This will take several minutes to compute.</td>
</tr>
<tr>
<td>Load FSL Surface</td>
<td>Load a previously extracted FSL surface mesh (*.off)</td>
</tr>
<tr>
<td>View FSL Surface</td>
<td>Preview FSL surface files.</td>
</tr>
<tr>
<td>Save FSL surface as shape</td>
<td>Convert surface meshes into (*.shape) file.</td>
</tr>
<tr>
<td></td>
<td>*Required for generation of *_SURFACE.mat file.</td>
</tr>
<tr>
<td>Import Cortical Meshes</td>
<td>Load cortical meshes extracted from CIVET (<em>.obj, .vtk) or Freesurfer (</em>.asc, or other binary file, e.g., lh.pial) programs. Prompt will ask for left then right hemisphere files.</td>
</tr>
<tr>
<td></td>
<td>*Required for generation of *_SURFACE.mat file.</td>
</tr>
</tbody>
</table>
## Segmentation

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warp Template Mesh to MRI...</td>
<td>Warps a template cortical surface mesh (adult CH2) to the subject’s own MRI, then saves ch2_template_SURFACE.mat file. Useful if not CIVET or Freesurfer surfaces. This can now be used as an estimated template surface for 3D rendered previews with beamformer activity. <em>Not a substitute for subject’s own cortical renderings.</em></td>
</tr>
<tr>
<td>Load Cortical Surface</td>
<td>Load a previously generated surface file (via CIVET or Freesurfer).</td>
</tr>
<tr>
<td>View Cortical Surface</td>
<td>Preview 3D-rendered image of currently loaded surface file.</td>
</tr>
<tr>
<td>Save Mesh Hull as shape...</td>
<td>Calculates a curved surface (“hull”) that skims the top of the gyral surface of the currently loaded CIVET or Freesurfer extracted surface, and saves as <em>brainHull.shape</em>. Used as an alternate surface to FSL To use brain shape as a surface for fitting spherical head model.</td>
</tr>
</tbody>
</table>

## Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Options...</td>
<td>A prompt will offer options to increase mesh marker size (red dots that represent the loaded surface), normals tail width and length size, and the option to select SPM for DICOM conversions (<em>REQUIRED when importing Philips™ scanner images).</em></td>
</tr>
</tbody>
</table>

![Display options](image)
Features Description

Current Working Files are listed at the top of the window, and displays the location of the current MRI (.nii) and shape or overlay (.shape/.svl) files being used. It is important to refer to these when generating mesh, shape and head models. In addition to a NIfTI image, head model calculation requires a (.shape) file - take care to ensure that it is read here before proceeding.

(Three Images). There are three standard views displayed of the MRI (sagittal, coronal and axial).

Edit. Enables the ability to edit fiducial locations.

Set Na (nasion), Set LE (left ear) and Set RE (right ear) grab and store each coordinate in their respective boxes. Interactive cross-hairs and scroll bars enable you to slide through the different slices when choosing fiducial locations. Double-clicking on the display will enlarge each view.

View Na/LE/RE buttons enable you to quickly preview the currently locations of each.
Save Fiducials will update the subjectID.mat file (located in the MRI folder).

Undo changes can revert any recent changes to fiducial values back to the values from the previously saved fiducial header information prior to closing the window.

Brightness Bar has been added to improve the visibility of structures.

Overlay Threshold. Adjusts the amount of data shown when a beamformer result is overlaid on the MRI. The .svl files can be loaded from the File dropdown.

Find Peak. When an overlaid beamformer result is present, this feature will automatically navigate to the strongest peak location.

Show Dipoles. When a CTF dipole file (*.dip) is loaded, this feature will automatically navigate to the dipole location.

Show All Spheres displays all calculated head model spheres for multi-sphere head model calculations only.
3) Single Subject Analysis

Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Preferences File...</td>
</tr>
<tr>
<td>Save Preferences as...</td>
</tr>
<tr>
<td>Close</td>
</tr>
</tbody>
</table>

Features Description

Dataset Panel.

Users Documentation 76
**Change Dir.** Select the folder that contains your epoched subject datasets (*.ds). The list of datasets will appear within the dataset list above.

**Refresh.** Any changes or additions to the selected dataset folder (e.g., more epoched datasets added) may be refreshed here without the need of reloading the folder.

**Combine Datasets.** Two or more datasets can be combined by multi-selecting them from the dataset list before clicking **Combine Dataset.** A window will pop up to enable saving the new dataset to a chosen directory.

**Current File Parameters.** Pre-processed information about the currently selected (highlighted) dataset can be found directly next to the dataset list (number of sensors/trials, sample rate, original bandpass and trial duration). Processing parameters to be set for the currently selected dataset can be set using the **Data Parameters** button (see below), and will be updated in blue directly above the **Data Parameters** button.

**Plot Average.** Averaged MEG sensor data and field topography are plotted. Depending on sample rate, this may take a few moments to open. Arrow keys allow you to move the time cursor (red vertical line) in the plot, though can also be moved by clicking and dragging the time cursor. The field topoplot will update to display the new sensor data at that latency. **Bandpass** and **baseline** options have been added for additional viewing capabilities, but will NOT have an effect on the dataset parameters used for image calculations. The use of **zero phase shift** may also be previewed in this window. **Show sensors** will overlay the MEG sensor locations onto the topoplot. Additional viewing options include specifying mapping **planar rather than axial gradiometers** (for viewing Neuromag data only) and plotting RMS (**Plot RMS**) of the sensor signals. The latter may also be applied to a limited window surrounding the time cursor. Click **Integrate over trials** to initiate this feature. Sensor data may be viewed as **global field power** (ie. the RMS amplitude over all sensors as a single rectified waveform), **single channel** or **all channels** overlapped by selecting the plot mode from the **BrainWave** dropdown menu. Single trials may also be viewed for any selected channel (**Plot single trials...**) from the channel dropdown menu.
Plot VS. If a particular peak location (and orientation) are known, this option allows the ability to run a quick virtual sensor plot, without the need of generating or opening a previously generated beamformer. Coordinates may be entered in CTF (cm), Talairach (mm) or MNI (mm) space.

Data Parameters. The parameters set here will be used in the calculation of the beamformer, virtual sensor (VS) and time frequency representation (TFR) plots.
**Highpass** and **Lowpass** bandpass filters are applied to the prior to the covariance calculation for beamformer and virtual sensor data, using a non-phase shifting (bi-directional), 4th order Butterworth filter. If disabled, the original bandpass settings will be used without any additional filtering.

**Zero phase shift** will apply the filter forwards and backwards over the data (i.e., two passes of a 2nd order filter) to correct for any temporal delays introduced by the digital filter. Turning this option off will result in latency shifts of peaks in waveforms, but will avoid smearing of any signal amplitude backwards in time. Using a zero-phase shift option is recommended for most purposes.

**Baseline Correction.** Sets the filter time range to use for baseline (offset) correction to be applied to data prior to calculating images and virtual sensors, including baseline correction of time-frequency plots.

**Beamformer Parameters Panel.** Choose between two beamformer types (see Appendix 1 for details of beamformer computation):

a. **Scalar** – this computes one-dimensional beamformer weights using a single current source (single current dipole) at each brain location (voxel). The “optimal” orientation corresponds to the weights that pass the maximal amount of signal energy. This is computed using eigendecomposition of the output of the vector beamformer source power (see below) derived from the data corresponding to the covariance time window.

b. **Vector** – this computes multi-dimensional beamformer weights using two sources (2 current dipoles) for each brain location. Since a spherical model is used, source activity pointing in the radial direction is not detected by the MEG while the sources are in two orthogonal directions (pointing in azimuthal and longitudinal directions) in the plane orthogonal to the radial direction are detected.

**Covariance windows.** are given a start and end time, and are used calculate beamformer weights. A smaller window can be used to bias the beamformer weights to be more sensitive to a particular period within the data epoch.

**Apply diagonal regularization.** A constant noise power estimate (regularization factor) can be applied to the diagonal of the covariance matrix prior to computing the inverse with the **Apply diagonal regularization** option (in femtoTesla squared) is currently set to a default of 10 femtotesla (fT). This can be used in cases
where the stability of the covariance inverse may be compromised (e.g., in cases with very few sample points, using averaged data, or if data has been preprocessed using techniques that may have reduced the rank of the covariance matrix, such as denoising using independent component analysis (ICA) or signal space separation (SSS)). The appropriate amount of regularization may require trial-and-error. Generally, greater than 20 femtoTesla squared will be sufficient to deal with rank-deficient data.

⚠️ **NOTE:** Large regularization values may result in highly smoothed images due to loss of spatial resolution of the beamformer.

**Head Models Panel.**

Head models are used for magnetic field forward calculations. **Single sphere origin** (default: 0,0,5cm) allows you to specify the x, y and z coordinates of the origin of a single conducting sphere model. All coordinates are in MEG head coordinates. **Use Head Model File** allows you to specify a single or multiple overlapping sphere model saved in a CTF Head Model format (*.hdm). This file can be created in the MRI Viewer/Head Models GUI as described in the tutorial section of this documentation.

**Beamformer Normalization Panel.**

Set the noise power estimate (in femtoTeslas per square root hertz) to an estimate of the MEG system noise. The value is used to scale the noise normalized beamformer images and waveforms, into unites of **pseudo-Z**. See Appendix 1 for details.

**Beamformer Parameters.**

**Event-Related Beamformer (ERB).** Produces a sequence of source images at instantaneous latencies by selecting a time window (a range - with start and end times - or a list of specific latencies) of interest within the trial. The mean image across the time window range can be determined using the **compute mean** checkbox. All time units are in seconds (s). Custom latency lists (*.txt and *.mrk formats) may be imported using **Read from File**. Alternatively, latencies may also be selected from the **Plot Average** window by pressing the **Add Map Latency** when the time cursor (red line) is at a time of interest. Latencies can also be added manually by typing them directly into the latency list window. In some cases, the use of another dataset’s covariance matrix calculation may be useful, for example, if you want to compare across
conditions with very different numbers of trials, “common” beamformer weights and source orientations can be derived by using a control condition dataset, or a dataset comprised of the combination of all conditions to compute the covariance and weights. Alternatively, if the data has been de-noised resulting in the covariance matrix being rank-deficient, the non-denised dataset can be used to generate weights. This can be enabled with the **Use different covariance dataset** checkbox.

**Synthetic Aperture Magnetometry (SAM).** Differential beamformer analysis options include **Pseudo-Z**, **Pseudo-T** or **Pseudo-F**, where each metric enables the appropriate associated active and baseline window options. If a non-zero $N$ number of steps (**No. Steps**) is specified, the program will generate a sequence of $N$ images by shifting the active window forward by **Step Size** seconds for each image (a.k.a., a sliding window SAM). Different datasets may also be used as an alternative baseline reference by enabling the **Use different baseline dataset** option. Computational formulae for SAM images are given in Appendix 1.

**Image Type.**

**Image options.** This window allows you to set various optional image parameters, such as the bounding box and voxel step size. The ability to apply a brain mask to a beamformer image may also be set here.

**Volume.** Choose between MEG (CTF) and MNI coordinate spaces. Each will be plotted onto a 2-D glass brain.

**Surface.** Load a * _SURFACE.mat file with the Select button to enable a 3-D rendered surface projected beamformer. Preview the surface with the View button.

**Generate Images.** Generate Images may take several minutes to load – especially surface beamformers.
## 4) Group Image Analysis

### Dropdown Menu Options

### File

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Study...</td>
<td>Create new study. All settings and files will be saved to a *_STUDY.mat file.</td>
</tr>
<tr>
<td>Open Study...</td>
<td>Open a previously saved *_STUDY.mat file.</td>
</tr>
<tr>
<td>Save Study...</td>
<td>Save all current datasets, settings, etc. to your *_STUDY.mat file.</td>
</tr>
<tr>
<td><em>SAVE after each setting change.</em></td>
<td></td>
</tr>
<tr>
<td>Save Study As..</td>
<td>Saves all current datasets, settings, etc. to a <strong>NEW</strong> _STUDY.mat file.</td>
</tr>
<tr>
<td>Add Condition...</td>
<td>Add all epoched datasets for a single condition type. E.g., multi-select all left button press datasets.</td>
</tr>
<tr>
<td>Remove Condition...</td>
<td>Removes a selected dataset from the current list.</td>
</tr>
<tr>
<td>Combine Conditions...</td>
<td>Combine two conditions into a single condition.</td>
</tr>
<tr>
<td>Copy Head Models...</td>
<td>Copy head models from one condition to any newly epoched datasets without having to manually do this through MRIViewer.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current group image analysis window.</td>
</tr>
</tbody>
</table>

### Batch

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open New Batch</td>
<td>Opens the ability to run multiple processes in succession. Nothing will appear to happen overtly – simply start making any changes to the current settings, and press “Generate Group Images” button to append process to the batch list.</td>
</tr>
<tr>
<td>Close Batch</td>
<td>Ends the ability to add more processes to the batch list.</td>
</tr>
<tr>
<td>Run Batch</td>
<td>Start processing the batch list.</td>
</tr>
</tbody>
</table>
ImageSets

A quick view feature when previously saved group images in the current directory.

Features Description

![ImageSets](image)

**Conditions 1 & Condition 2.** Dropdown list will display all currently loaded datasets for that condition for analysis.

+ Append additional datasets to the list for analysis.

- Delete highlighted datasets from the list.

**Generate Image for...**

- **Condition 1.** Will apply a group beamformer analyses to Condition 1 only.

- **Condition 2.** Will apply a group beamformer analyses to Condition 2 only.
• **Condition 1 minus Condition 2.** Generates two single condition group average analysis (Condition 1 only then Condition 2 only), then subtracts the averaged images where condition 2 will be subtracted from condition 1.

**Compute beamformer Weights using**

• ! Beamformer weights are based on the covariance matrix calculated from the data in the specified time windows in Data Parameters for all epochs. There are currently three options for specifying the covariance data to be used to compute the beamformer weights, which are then applied to the data to generate images and waveforms.6

• **Each Condition Separately.** Sensor weight calculations will be generated for each condition only based on the covariance data for each given condition.

• **Conditions 1 and 2 (common weights).** This feature will generate an additional dataset that is the combination of the two conditions. Beamformer weights will then be calculated using the covariance derived for this combined dataset, and applied to the different conditions in group analyses (i.e., Condition 1 or 2 only or contrast image). This is option is recommended when comparing two conditions, particularly amplitude changes, since differences will not be biased by slight differences in the computed weights (and dipole orientations for the scalar beamformer) that might result from different SNR (e.g., number of trials) between two conditions.

• **COVARIANCE Condition.** This feature will utilize an alternate dataset list for the covariance matrix calculation. A covariance condition dropdown menu will become enabled (to the right) allowing you to select a different dataset name for covariance (weight) calculation.

**Covariance (dropdown).** Lists the datasets that will undergo covariance calculations for a specified group analysis.

**Beamformer Parameters & Image Type Panels.** **A full description of these can be found in the single subject analysis section of this documentation.**

6 Note that covariance datasets (rather than beamformer weight files) are specified. This is because BrainWave does not store beamformer weights into disk files due to their large file size, and slow computation. Instead, the weights are computed each time from the covariance matrices which uses a faster multithreading operation, then saved as .cov files in each dataset directory, and reused when possible.
5) Group VS Analysis

⚠️ MATLAB Signal Processing Toolbox REQUIRED to perform Hilbert Transformation Analysis.

### Dropdown Menu Options

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Voxel List...</td>
<td>Loads previously saved voxel lists in both current (.vs) and older (*.vlist) file formats.</td>
</tr>
<tr>
<td>Load VS Plot (.mat)</td>
<td>Opens a previously saved virtual sensor plot (*.WAVEFORMS.mat)</td>
</tr>
<tr>
<td>Save Voxel List</td>
<td>Save the current voxel list to a virtual sensor file (*.vs). Save Condition 1 first, then Condition 2 (if present) to a separate file.</td>
</tr>
<tr>
<td>Save Raw VS Data</td>
<td>Saves the raw virtual sensor data to a text file for further analyses.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current window.</td>
</tr>
</tbody>
</table>

### Features Description

- **Virtual Sensor Plot**
  - Average
d  - Average + Single Trials
d  - Make positive
d  - Make negative
d  - Softmax Average from Single Trials
- **Time-Frequency Plot**
  - Frequency Step (Hz)
  - Hilbert Transform
  - Save Time-Waveform (custom use only)
- **Virtual Sensor Parameters**
  - VU Units
  - Moment
  - Phase
  - Plot Selected Only
  - Plot Condition 1
  - Plot Condition 2

- **Virtual Sensor Coordinates**
  - Condition 1
  - Condition 2
  - Condition 3
Virtual Sensor Plot Panel.

**Average Only.** Generate an averaged trial virtual sensor time course plot. If multiple datasets are listed in the VS Parameters scroll window, a group averaged VS time course plot will be created.

**Average + Single Trials.** An averaged trial VS time course plot will be generated, and raw trial time course data will also be saved. This allows for additional analytical ability, such as the Hilbert Transformation (more on this later, see *The Virtual Sensor (VS) Plot* section).

**Make polarity positive/negative at [XX] seconds** allows you to force the polarity of the dipole orientation vector by 180 degrees, which is often necessary in comparing virtual sensors in different brain locations, or across subjects.

**Subtract Average from Single Trials.** When selected the average is subtracted from each single trial prior to further processing or plotting. This removes any phase-locked activity (e.g., an evoked response) from single trial datasets such that the resulting plot only represents the remaining non-phase locked activity. This is an important step for viewing induced changes in power in the time-frequency plots (either TFR or Hilbert transform) to avoid the spectrogram from being biased by the power of the evoked or other phase locked activity, for example when looking at changes in theta or alpha power following a sensory stimulus.

**Plot VS.** A dropdown menu provides multiple virtual sensor plot options. Choose to plot only one condition (Condition 1 Only or Condition 2 Only), Plot Condition 1 and 2, or Plot Condition 1 minus Condition 2. Click Plot VS to plot the chosen virtual sensor plot.

Time-Frequency Plot Panel.

**Frequency Step (Hz).** Specifies the frequency bin step size for the wavelet transformation in Hertz (Hz). Default bin size is 1 Hz.

**Morlet Wavelet.** Creates a TFR by convolving the data with morlet wavelets corresponding to each frequency bin. Text field specifies the number of cycles used to generate the Morlet wavelets. Higher Wavelet Width values (number of cycles per wavelet) will provide better frequency resolution, with a trade-off of poorer temporal resolution. Default is 7 cycles.

**Hilbert Transform.** Creates a TFR using the Hilbert Analytical Signal to derive the amplitude envelope for each frequency bin after bandpass filtering the data about the center frequency. The Filter Width specifies the width of the bandpass filter. A lower Filter Width value will provide a better frequency
resolution, with a trade-off of poorer temporal resolution. Default is a filter width of 4Hz which corresponds to ±2Hz around the center frequency).

**Save Trial Magnitude/Phase (custom use only)**. Saves the magnitude and phase values for every trial. This only applies to the Morlet wavelet TFRs and is not currently used by BrainWave but saves this information in the .mat files if the TFR plots are saved. This option will result in very large file sizes so should be left unselected unless saving this information is desired.

**Plot TFR.** A dropdown menu provides multiple time frequency representation plot options. Choose to plot only one condition (Condition 1 Only or Condition 2 Only), Plot Condition 1 and 2, or Plot Condition 1 minus Condition 2. Click Plot TFR to plot the chosen TFR plot.

**Virtual Sensor Parameters Panel.**

**VS Units.** Units of power for both virtual sensor and time-frequency representation plots, can be displayed in Moments (nanoAmpere-meters) or Pseudo-Z. The latter is corrected for spatial distortions in the beamformer image using the pseudo-Z scaling (ie. the same units as the volumetric images). The former are in absolute units of source strength (dipole moment).

**Use Orientation Vector.** This option allows you to select specific or customized orientations for each peak by first importing a previously saved .vlist or .vs files, then selecting Use Orientation Vector.

**Plot Selected Only.** If multiple datasets are listed (group analysis), you may choose to run a VS or TFR plot on a single dataset by selecting the Plot Selecting Only checkbox.

**Data Parameters.** See Single Subject Analysis for more details on this window.

**VS Coordinates.**

Two panels will display the dataset names where the peak was generated, the dataset names where the covariance matrix was calculated, the peak position(s), and orientation(s), for Conditions 1 and 2.

**Select Condition & Select Covariance.** Perform alternate analyses using other lists of conditions or covariance matrices using the Select Condition or Select Covariance buttons. A prompt will ask for the *_STUDY.mat file containing calculated beamformer previously analyzed datasets to be swapped into the current list.
Archive: Average/Permute

Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the current window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Batch</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Open New Batch</td>
<td>Opens the ability to run multiple processes in succession. Nothing will appear to happen overtly – simply start making any changes to the current settings, and press “Generate Group Images” button to append process to the batch list.</td>
</tr>
<tr>
<td>Close Batch</td>
<td>Ends the ability to add more processes to the batch list.</td>
</tr>
<tr>
<td>Run Batch</td>
<td>Start processing the batch list.</td>
</tr>
</tbody>
</table>

Features Description

- **Read List.** Opens a previously created list (*.list file) of a group of previously generated, warped images (w*.nii).
- **Add File.** Append additional image files to the list for averaging and/or permutations analysis.
Delete File. Remove a selected image file from the list.

Clear List. Removes entire list of images.

Create Contrast Images. Subtracts images computed for Condition B list from images computed for Condition A list.

Plot Individual Images. Averaged Talairach (.nii) image for each subject will appear in addition to the group averaged image.

Alpha. The statistical significance threshold (alpha) may be adjusted. The default is currently set to a P-value of 0.05.

No. of Permutations. This value is the highest number of permutation combinations that can be performed on the images listed.

Use ROI (MNI coords in mm). The default region of interest (ROI) values has been set to include the entire brain in MNI coordinates (in millimeter, mm, measurements), where X+ is to the right, Y+ is to the anterior, and Z+ is to the superior. These values may be adjusted to bias specific regions of the brain, as necessary.

Average. This button generates an averaged Talairach image of the selected group list. NOTE: The generated image is virtually the same as the group-averaged image created with Group Image Analysis.

Permute and Average. This button will apply an omnibus permutation across the list(s) of images. If a significant peak is found, the group image will display only the regions of significance at the significant threshold value. In addition, a permutation distribution figure will display the histogram of peak values, where peaks shown to the right of the red vertical line are of alpha significance.

Permutation Result (significant peak image with permutation distribution plot):
Navigating Generated Figures/Images

This section will describe each feature and option within each BrainWave image output. Additional information about each can be found in the tutorial section.
# Beamformer: Volumetric Image

## Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Images</td>
<td>Load previously saved beamformer images of the following types: VOLUME_IMAGE.mat, SAM Volume files (<em>.svl), Normalized NIfTI files (w</em>.nii), Normalized Analyze (w*.img), List file (<em>.list) and NIfTI (</em>.nii).</td>
</tr>
</tbody>
</table>
| Save Images   | Save current beamformer image in *VOLUME_IMAGES.mat* format.  
*All interactive features and parameters will be preserved and may be re-opened by *BrainWave*.                                                                                                               |
| Save Thresholded Image | Save the current latency window at a specified threshold value. Will save as a single NIfTI (*.nii) or Analyze Format (LAS/RAS, *.hdr and *.img) file.                                                                                           |
| Save Image List | Creates a BrainWave list file of all latency images (*.list – backwards compatible)                                                                                                                                                                                                                      |
| Save Figure   | Saves the current latency window to a picture format (.eps, .tif, .jpg, .png, .bmp or .pdf).                                                                                                                                                                                                                          |
| Save as Movie | Saves all latency windows in sequence as a movie file (*.avi or *.gif).                                                                                                                                                                                                                                                                  |
| Overlay Image on MRI | Load a beamformed result onto an MRI. A non-normalized image files with the same name will be automatically loaded.                                                                                                                                                                                                                                         |
| Render Image on Template Brain | **(ONLY for MNI IMAGES)** Utilizes the default adult template brain (ch2.nii) to render a 3D brain, then overlays the subject beamformer.  
*For estimation purposes only. Not to be used as substitute for subject’s own rendered brain.*                                                                                                                                                                                                 |
<p>| Show Data Parameters | Pop-up window allows you to adjust data parameters such as Highpass and Low Pass filters and the covariance window. See full description in <em>Single Subject Analysis</em> section.                                                                                                                   |</p>
<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
</tr>
<tr>
<td>Pop-up window enables you to adjust Grey Matter search radius, minimum separation between peaks, maximum number of peaks, as well as to choose a template surface file for plotting 3D surface images (using <strong>Plot 3D</strong>).</td>
</tr>
</tbody>
</table>

| Print                   |
| Print the current image. |

| Close                   |
| Closes the current window. |

<table>
<thead>
<tr>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>(*Group Analysis Only)</td>
</tr>
</tbody>
</table>

| *  |
| Displays individual datasets (*a list of datasets would appear in the group image “data” dropdown menu). |

| * Group Average         |
| Displays the averaged group beamformer of all individual datasets listed above. |

| *Permute Images         |
| Pop-up window enables adjustment of alpha, number of permutations etc., before running permutation. Option to generate a plot distribution when run. See Archive: Average/Permute Images section for more in depth description of options. |
### Features Description

#### MEG Coordinates

<table>
<thead>
<tr>
<th>Image Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="MEG Coordinates" /></td>
</tr>
</tbody>
</table>

#### MNI/Talairach Coordinates

<table>
<thead>
<tr>
<th>Image Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2.png" alt="MNI/Talairach" /></td>
</tr>
</tbody>
</table>

**Plot 3D.** Button is available for MNI images. Use this button to preview the current latency on a 3D template brain (CH2).

**Latency slider.** Use the latency slider at the bottom of the window to move from one time window to the next.

**Latency box.** Change the latency in the box next to the latency slider to navigate directly to a specified time.

**Show Peaks.** Displays all of the peaks present at the current latency window. Clicking on any of the peaks in the list will draw blue cross-hairs onto the selected location of the image.

**Threshold slider.** Controls the number of peaks.

**Show Positive/Negative.** By default, only positive peaks will be displayed. When available (e.g., SAM beamformer images), you may also view negative peaks by selecting the Show Negative radio button.

**Add peak to List.** This button will open a new window that allows you to save the list of peak locations (and orientations) into a BrainWave .vs file. An MNI to MEG coordinate calculation will be made for normalized and group-averaged image peaks. In this case, choose either exact or a search radius around the group MNI coordinate listed, then click OK. The virtual sensor list will display all subject peaks in MEG coordinates. To save, go to File → Save Voxel list...
BrainWave v3.5

Convert to MEG coordinates

![Convert MNI Coordinates to MEG](image)

Save Peaks to .vlist File

![Virtual Sensor List](image)

**Plot VS.** Generate virtual sensor analyses on the currently selected peaks. See *The Virtual Sensor Plot* and *The Time-Frequency Representation Plot* sections for more information.
**Beamformer: Surface Image**

**Dropdown Menu Options**

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open ImageSet</td>
<td>Opens previously saved *SURFACE_IMAGES.mat file.</td>
</tr>
<tr>
<td>Save ImageSet</td>
<td>Save current beamformer image in *SURFACE_IMAGES.mat format.</td>
</tr>
<tr>
<td></td>
<td><em>All interactive features and parameters will be preserved and may be re-opened by BrainWave.</em></td>
</tr>
<tr>
<td>Create Movie</td>
<td>Saves all latency windows in sequence as a movie file (*.avi or *.gif).</td>
</tr>
<tr>
<td>Export Image</td>
<td>Saves the current latency window image in a picture format (.eps, .tif, .jpg, .png, .bmp or .pdf).</td>
</tr>
<tr>
<td>Import Data</td>
<td>Import previously saved overlay files (*.txt, ASCII format).</td>
</tr>
<tr>
<td>Preferences</td>
<td>Specify Talairach search radius (default is 5mm)</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Preferences" /></td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current window.</td>
</tr>
</tbody>
</table>

**Options**

<p>| Shading               | Choose between smoothed (interpolated) or exact voxel (No interpolation) peak shading. <strong>Faceted</strong> overlays the triangulated mesh to outline all voxels. |
| Template Coordinates  | Choose to display peaks in either <strong>MNI</strong> or <strong>Talairach</strong> coordinates when using the <strong>Cursor</strong> option. |</p>
<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Controls</td>
<td>This feature removes most figure settings for creating quick images for PowerPoint presentations or publications.</td>
</tr>
<tr>
<td>Reset Camera Light</td>
<td>Reset the surface lighting at anytime with this feature.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Displays individual datasets (*a list of datasets would appear in the group image “data” dropdown menu).</td>
</tr>
<tr>
<td>*Group Average</td>
<td>Displays the averaged group beamformer of all individual datasets listed above.</td>
</tr>
<tr>
<td>*Permute images</td>
<td>Pop-up window enables adjustment of alpha, number of permutations etc., before running permutation. Option to generate a plot distribution when run. See Archive: Average/Permute Images section for more in depth description of options.</td>
</tr>
</tbody>
</table>
**General.** The surface image file projects the beamformer onto the surface of a 3D rendered brain generated by CIVET or FreeSurfer. Latency bar, threshold and autoscale features will work similarly to those seen in the volumetric image. Options in the left side column allow you to **rotate**, **zoom** and **pan** the surface of the brain.

**View Angle.** For ease, you may view **top**, **bottom**, or side (**left** or **right**) surfaces.

**Hemisphere.** Either hemisphere may be viewed separately or together.

**View Inflated.** Displays a BrainWave calculated semi-inflated surface for CIVET meshes, or the Freesurfer inflated surface located in the original surface extraction folder.

**Cursor.** To select peaks, enable the Cursor option, and click anywhere on the brain surface. Information about the peak will appear in the bottom right corner of the figure. **RIGHT-CLICK** on the selected peak to display some basic MATLAB options, like switching to datatip view, and a BrainWave dropdown. The latter enables the same **Plot VS** and **Add Peak to List** features as described in *Program Navigation: Beamformer: Volumetric Images* section.

**Find Peaks.** This feature will list all peak locations within the current time window. Clicking on each will highlight the location on the brain surface (*the Rotate option may be required to bring peaks into view).*
Plot VS. Generate source analyses (Virtual sensors or TFR plots) on any peak (found either manually using the Cursor mode or via Find Peaks feature).
The Virtual Sensor (VS) Plot

Dropdown Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Voxel List</td>
<td>Open previously saved voxel list file (.vs OR .vlist).</td>
</tr>
<tr>
<td>Load VS Plot (.mat)</td>
<td>Open previously saved virtual sensor plot (*.WAVEFORMS.mat).</td>
</tr>
<tr>
<td>Save Voxel List</td>
<td>Save peak voxel locations/orientations into a voxel list (.vs) file.</td>
</tr>
<tr>
<td>Save Raw VS Data</td>
<td>Save all raw virtual sensor (unaveraged) trials to a file (*.mat OR *.raw [ASCII format]). The former may be opened in MATLAB. The latter may be imported into a spreadsheet program.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current group VS analysis window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BrainWave</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save VS Plot</td>
<td>Save the waveform with its current parameters to a *.WAVEFORMS.mat file.</td>
</tr>
<tr>
<td></td>
<td>*All interactive features and parameters will be preserved and may be re-opened by BrainWave.</td>
</tr>
<tr>
<td>Export Data</td>
<td>Export raw waveform data to a file (*.mat or *.txt [ASCII]). These files may be opened in MATLAB or spreadsheet program for additional analyses.</td>
</tr>
</tbody>
</table>
### BrainWave v3.5

#### Plot Average
Display the trial average virtual sensor waveform (original plot).

![Plot Average Example](image1.png)

#### Plot Average + PlusMinus
Displays the trial average virtual sensor waveform with an overlaid subtracted phase-locked power waveform. Only available for Average + Single Trials plots (option in Virtual Sensor Analysis window).

![Plot Average + PlusMinus Example](image2.png)

#### Plot Single Trials
Display all raw virtual sensor waveform trials. Only available for Average + Single Trials plots (option in Virtual Sensor Analysis window).

![Plot Single Trials Example](image3.png)

#### Show Standard Error
Show standard error on the plot. Options are none, shaded, or as bars.

*Only available for group averaged waveforms.*
<table>
<thead>
<tr>
<th>Change Plot Colour</th>
<th>Select line colour style options for your plots.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Plot Parameters</td>
<td>Apply alternate filters and baselines. The settings for error bars (<em>group VS plots only</em>) or calculate a Hilbert Transformation (in units of Moments) may be selected here.</td>
</tr>
</tbody>
</table>
| Data Source | Eliminates the need to plot individual subject VS plots separately. Instead, easily toggle between individual and group VS plots here.  
*Only available for group averaged waveforms.* |
# The Time-Frequency Representation (TFR) Plot

## Dropdown Menu Options

<table>
<thead>
<tr>
<th>BrainWave</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save TFR Data</strong></td>
</tr>
<tr>
<td>Saves TFR with current parameters that can be re-opened in <em>BrainWave</em> (*.mat) from the Main Menu GUI.</td>
</tr>
<tr>
<td><strong>Save Time Course</strong></td>
</tr>
<tr>
<td>Export time course values to a *.txt file.</td>
</tr>
<tr>
<td><strong>Plot Parameters</strong></td>
</tr>
<tr>
<td>Make temporary adjustments to TFR parameters. Apply bandpass filters WITHIN the original generated TFR bandpass, readjust baselines, and add error bars (for group time courses only).</td>
</tr>
<tr>
<td><img src="image.png" alt="Plot Parameters" /></td>
</tr>
<tr>
<td><strong>Show Time Course</strong></td>
</tr>
<tr>
<td>Displays the time-course of power collapsed over all frequency bins in the plot. This is mainly used when computing TFRs over narrow frequency bands (e.g., beta or theta band activity at a given voxel).</td>
</tr>
<tr>
<td><strong>Change Plot Colour</strong></td>
</tr>
<tr>
<td>Allows you to select a colour for the plotted line without the need to enter edit mode.</td>
</tr>
</tbody>
</table>

*Only available for Time Course plot*
<table>
<thead>
<tr>
<th><strong>BrainWave</strong></th>
</tr>
</thead>
</table>
| **Change Colormap** | Allows you to select one of five colormaps for the TFR plot. The options are Parula, Gray, Hot, Cool, and Jet. Jet is the default colormap, which the plot is displayed in upon generation.  
*Only available for TFR plot* |
| **Show Standard Error** | Displays the time-course plot with error bars placed every XX millisecond intervals with the **Bars** option or choose the **Shaded** error line option. Below is an example of the beta band time course of a group averaged motor response.  
*Only available for group averaged waveforms.* |
| **Show Values** | Displays the peak values at a specified latency time point. This feature is synonymous to the data-tip feature in MATLAB - simply copy and paste values into a spreadsheet or word program for additional post-hoc analyses.  
*Only available for group averaged waveforms* |
| **Plot** | **Total Power**<br>Displays the baseline adjusted total power of VS data.  
**Power-Average**<br>Plots the total power after subtracting the power of the average of the single trials. This can be used to view the power that is non-phase-locked to the epoch trigger time (sometimes referred to as “induced power”).  
**Average**<br>Plots the evoked power (i.e., the power of the average only).  
**Phase-Locking Factor (PLF)**<br>Plots the correlation of phase to the trial onset. This is always plotted in units of 0 to 1, where 1 represents complete phase synchrony (i.e., the phase angle is identical across all trials). Zero would represent completely random phase across trials (*Lachaux et al. 1999*). |
|---|---|
| **Units** | **Power**<br>Plots the TFR in units of power of Moment (nAm^2).  
**Power (dB)**<br>Plots power relative to the baseline value computed in units of decibels, where the value at each time point is calculated according to the following formula:  
\[
Power (dB) = 10 \times \log_{10} \left( \frac{Power}{Baseline\ Power} \right)
\]  
**Percent Change** *(Default)*<br>Plots TFR power as a percent change from the baseline value, where the value at each time point is calculated according to the formula:  
\[
Percent\ Change = 100 \times \frac{(Power - Baseline\ Power)}{Baseline\ Power}
\] |
<table>
<thead>
<tr>
<th>Data Source</th>
<th>Eliminates the need to plot individual subject’s TFR separately. Instead, easily toggle between individual and group TFRs here.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>* Only available for group averaged waveforms.</td>
</tr>
</tbody>
</table>
Appendices

*Important notes, calculations, and information on file types may be found in this section.*
APPENDIX 1: Minimum-Variance Beamforming and SAM Calculations

Minimum-Variance Beamforming

We denote the measured magnetic field magnitude as a function of time \( t \) for the \( m \)th detector as \( b_m(t) \) and the measured field as the vector \( \mathbf{m}(t) \) where

\[
\mathbf{m}(t) = [b_1(t), b_2(t), \ldots, b_m(t)]^T \quad (1).
\]

We then define a beamformer spatial filter for a given brain location, defined by the three-dimensional position vector \( \mathbf{r} = (x, y, z) \), as a unique set of coefficients or weights (one weight per MEG detector) denoted \( \mathbf{w}(\mathbf{r}) \). The total power projected by the filter for this location \( S^2(\mathbf{r}) \) over some interval of time \( T \) is given by the temporal integration of the measured data as a function of time multiplied by the weights

\[
S^2(\mathbf{r}) = \int_T \mathbf{w}^T(\mathbf{r}) \mathbf{m}(t) \, dt \quad (2).
\]

where \( T \) denotes transpose. If the weights must account for more than one source at each location we replace \( \mathbf{w}(\mathbf{r}) \) with a multidimensional weight matrix \( \mathbf{W}(\mathbf{r}) \) and the above expression can be more conveniently written as

\[
S^2(\mathbf{r}) = \text{tr}\left\{\mathbf{W}^T(\mathbf{r}) \mathbf{C}_m \mathbf{W}(\mathbf{r})\right\} \quad (3)
\]

where \( \mathbf{C}_m \) represents the measured data covariance matrix computed over the time interval \( T \) and \( \text{tr}\{\} \) represents the trace of the resulting \( N \times N \) matrix for a \( N\times M \)-dimensional spatial filter given by \( \mathbf{W}^T \). To derive a spatial filter that minimizes contributions from all sources, yet passes activity for
the source of interest with known magnitude, we seek weights that will minimize total power output of the spatial filter given by (3), while retaining unity gain for the forward solution for the target source. This can be expressed as the following minimization problem:

$$\min_{W(r)} S^c(r) = \mathbf{W}^T(r) \mathbf{C} W(r)$$

subject to,

$$W^T(r) H(r) = I \quad (4)$$

where $H(r)$ represents the $N$ by $M$ matrix of forward solutions, where $N$ is the number of forward solution vectors, one forward solution for current flow in each orthogonal direction\(^7\). When a spherical model is used, only tangentially flowing currents contribute to the MEG signal, and $H(r)$ is represented by two orthogonal tangential dipoles with forward solutions denoted $B(r,u_q)$ and $B(r,u_f)$ such that $H(r) = [B(r,u_q), B(r,u_f)]$. The solution to (4) can be solved using the associated Lagrange multiplier function, resulting in what is commonly referred to as the \textit{linearly constrained minimum-variance} or LCMV beamformer (Van Veen et al. 1997) because it involves minimization of the signal power or variance with multiple linear constraints for response of the filter to sources with orthogonal orientations at location $r$. The solution is given by

$$W(r) = \mathbf{C}^{-1} H(r) [H^T(r) \mathbf{C}^{-1} H(r)]^{-1} \quad (5)$$

\(^7\) In BrainWave, the forward solution is based on either a single, or multiple overlapping spherical model, with corrections for volume currents using the solution by Sarvas, 1987 as described in Appendix 3.
where $C_m$ the data covariance matrix based on the measured signals for the data segments of interest, and $W(r)$ is the resulting $N \times M$ weight matrix.

The solution for the beamformer weights given by (5) requires computing the measurement covariance matrix inverse, $C_m^{-1}$ and thus assumes this matrix is well estimated and nonsingular. In some cases this may not be true (e.g., in the case of averaged data) and regularization of the covariance matrix may be required prior to computing the beamformer weights, typically by replacing $C_m^{-1}$ with $[C_m + \mu I]^{-1}$, where $\mu$ is a parameter that determines the amount of regularization and $I$ is the identity matrix. It is important to point out here that increasing the amount of regularization of $C_m$ decreases the spatial selectivity of the beamformer as it decreases the contribution of the spatial correlation between sensors (i.e., the off-diagonals of $C_m$). Thus regularization of $C_m$ acts as a trade-off between spatial resolution of the filter and sensitivity to noise. With no regularization ($\mu = 0$) the beamformer provides maximal resolution and therefore optimal ability to separate closely spaced sources.

Since the covariance matrix $C_m$ is often computed only over the time period of interest, a convenient estimate of the total source power over this interval at the voxel location $r$ is given by

$$\hat{S}(r) = tr\{W(r)^T C_m W(r)\} \quad (6)$$

It might be noted here that if we only desire source power over the covariance time window, we can substitute (5) into (6)—in which case the weight vector terms cancel and the source power is given by $\hat{S}(r) = tr\{[H(r)C_m^{-1} H(r)^{-1}]\}$—without computing the weights directly. In the case of a scalar beamformer, where a single dominant current orientation can be estimated for each brain location, the weight matrix $W(r)$ simplifies to a single column vector $w(r)$ making it more convenient to compute the
output of the beamformer filter in units of source amplitude or moment (i.e., Ampere-meters) as a single time series (sometimes referred to as a “virtual sensor” or “virtual electrode”) for each brain location \( r \) as a function of time \( t \) given by

\[
S(r, t) = w(r)^T b(t)
\]  \( (7) \)

Since spatial filters based on beamforming coefficients with maximal spatial resolution should result in reduced or minimal crosstalk between multiple sources, the output of these filters can be used to create a volumetric source image by computing arrays of spatial filters at fixed spacing over a large region of the brain. However, the beamformer weights computed using equations (6) and (7) are unable to suppress uncorrelated noise, which will be amplified in a spatially non-uniform manner by the weights due to rapidly decreasing signal strength with increasing distance from the sensors, resulting in spatial distortions in the beamformer images (Van Veen et al. 1997). Fortunately this distortion can be effectively removed by normalizing the beamformer output by an estimated amount of the uncorrelated noise projected through the weights, by taking the ratio of projected signal power to projected noise power. The result is beamformer output that is scaled to units of noise variance. This has been termed the neural activity index (Van Veen et al. 1997) or pseudo–Z statistic (Robinson and Vrba 1999). If \( S_n \) is a diagonal matrix of estimated sensor noise variance the pseudo–Z statistic is given by

\[
Z^2(r) = \frac{\text{tr}\{W(r)^T C W(r)\}}{\text{tr}\{W(r)^T \Sigma W(r)\}}
\]  \( (8) \)

Similarly weight vector normalized beamformers may be employed (Huang et al. 2004; Sekihara et al. 2001) where the beamformer coefficients (equation 5) are normalized by the square of the weight vector matrix, that
is, by the gain of the weights. The estimate of source power directly from the weights is then free from spatial distortions, although output of such beamformers will be in arbitrary units.

Alternatively, the weight vectors can be normalized using the pseudo-Z scaling factor such that the output of Equation 7 is in units of pseudo-Z,

$$w_i(r) = \frac{w(r)}{\sqrt{\sum_{i=0}^{M} (w_i(r) n_w)^2}}$$

(9)

where $n_w$ is an estimate of the uncorrelated system noise. In *BrainWave* this value is set to a constant as specified in the Data Parameters dialog. The default value is $3 \text{ femtoTesla} / \sqrt{\text{Hz}}$ which corresponds to the typical noise floor of a CTF Systems Omega whole-head MEG system (e.g., the value of the smallest singular value of the data covariance matrix) and is scaled by the bandwidth of the data prior to normalization of the weights. It is important to note that this value is a linear scaling of the output of the beamformer weights, and if changed will not change the appearance of the images, only the absolute scale.
**Synthetic Aperture Magnetometry (SAM)**

Synthetic aperture magnetometry refers to a particular implementation of the minimum-variance beamformer method as described by Steve Robinson and Jiri Vrba (Robinson & Vrba, 1999). SAM is typically used to compute images of source power using a scalar beamformer, although in *BrainWave* a vector type beamformer can also be used. The output of SAM images is defined in terms of three different “metrics” termed *pseudo-Z*, *pseudo-T*, and *pseudo-F* that refer to, source power summed over a single time window, the difference (subtraction) of source power in two time windows, or the ratio of source power in two time windows, respectively. The pseudo-T is the most commonly used, although all three metrics are provided in *BrainWave*. SAM images are typically computed for narrow frequency band data, thereby providing a useful measure of the power, or change in power relative to baseline, for a given frequency band (e.g., to measure modulation of beta band activity during movements, or gamma band changes relative to stimulus onset. The calculation of SAM metrics are as follows:

\[
Pseudo-Z = W_n(r)^T C W_n(r)
\]

Where \( W_n(r) \) is the normalize weight matrix or vector and \( C \) the covariance matrix of the data measured over a single “active” time window.

\[
Pseudo-T = [ W_n(r)^T C_A W_n(r) ] - [ W_n(r)^T C_B W_n(r) ]
\]

Where \( C_A \) refers to the data covariance computed over the active window and \( C_B \) is the data covariance computed over the baseline window.

For pseudo-F the value is the ratio adjusted so that no difference between the two time windows will be equal to zero, and greater than zero if power in the active window is greater than the baseline window.

\[
Pseudo-F = f - 1 \quad (\text{for } f > 1.0)
\]
**Pseudo-F** = 1 – (1/ f)  \hspace{1cm} (for f < 1.0, f ≠ 0)

Where $f$ is the computed ratio of source power between time windows,

$$f = \frac{W^T_n(r) C a W_n(r)}{W^T_n(r) C b W_n(r)}$$
APPENDIX 2: Calculation of the Forward Solution

The forward solution for the field at an individual MEG sensor used for beamformer calculations in BrainWave is based on an equivalent current dipole in a uniformly conducting single sphere. For whole-head MEG systems with non-radially oriented sensors, the forward solution must include contributions of primary (impressed) currents, as well as volume currents that will contribute to non-radial components of the field measured outside of the sphere. For complex shapes the calculation of the external field therefore requires knowledge of the conductivity profile of the conducting volume. However, for a single sphere conductor model, the assumption of spherical symmetry simplifies this calculation, and the vector field measured outside of the sphere at location \( \mathbf{r} \) due to a tangentially oriented current dipole \( \mathbf{q} \) inside the sphere at location \( \mathbf{r}_o \) is given by Sarvas (1987)

\[
\mathbf{B}(\mathbf{r}) = \frac{\mu_0}{4\pi F^2} \left\{ \mathbf{F} \mathbf{q} \times \mathbf{r}_o - \left[ \left( \mathbf{q} \times \mathbf{r}_o \right) \cdot \mathbf{r} \right] \nabla F \right\}
\]

where the scalar term \( F \) and vector term \( \nabla F \) are given by,

\[
F = a \left( \mathbf{r} \cdot \mathbf{a} + r^2 - r_o \cdot \mathbf{r} \right) \quad (11.b)
\]

\[
\nabla F = \left( r^{-2} \mathbf{a}^2 + \mathbf{a} \cdot \mathbf{r} + 2a + 2r \right) \mathbf{r} - \left( a + 2r + \mathbf{a} \cdot \mathbf{r} \right) \mathbf{r}_o
\]

and \( \mathbf{a} = \mathbf{r} - \mathbf{r}_o \), \( a = |\mathbf{a}| \), \( r = |\mathbf{r}| \) and the permeability of free space, \( \mu_0 = 4\pi \times 10^{-7} \) H/m. The sensing coil measures the component of the vector field \( \mathbf{B}(\mathbf{r}) \) perpendicular to its surface area and the scalar output of the
magnetometer is the inner product of the vector field $\mathbf{B}(r)$ and the vector $\mathbf{p}$ normal to the surface of the sensing coil.
APPENDIX 3: File Formats

List Files (.list)

The list file is a simple ASCII file of file names (one name per line) that is used for group analyses or to specify a specific sequence of image files in BrainWave. The contents may be created using a text editor, or automatically when a sequence of images is computed (ie. ERB or sliding window SAM images), or by using the Save Image List option in the volumetric image File dropdown menus. A list file can be used to specify images for the purpose of permutation testing (.nii only).

Example of automatically generated image .list file (images every 5 msec from -100 to 0 milliseconds, using a bandpass of 1-50Hz, and a covariance window of -1 to 0.5 sec):

```
image,cw_-1_0.5,1-50Hz_time=-0.100.svl
image,cw_-1_0.5,1-50Hz_time=-0.095.svl
image,cw_-1_0.5,1-50Hz_time=-0.090.svl
image,cw_-1_0.5,1-50Hz_time=-0.085.svl
image,cw_-1_0.5,1-50Hz_time=-0.080.svl
image,cw_-1_0.5,1-50Hz_time=-0.075.svl
image,cw_-1_0.5,1-50Hz_time=-0.070.svl
image,cw_-1_0.5,1-50Hz_time=-0.065.svl
image,cw_-1_0.5,1-50Hz_time=-0.060.svl
image,cw_-1_0.5,1-50Hz_time=-0.055.svl
image,cw_-1_0.5,1-50Hz_time=-0.050.svl
image,cw_-1_0.5,1-50Hz_time=-0.045.svl
image,cw_-1_0.5,1-50Hz_time=-0.040.svl
image,cw_-1_0.5,1-50Hz_time=-0.035.svl
image,cw_-1_0.5,1-50Hz_time=-0.030.svl
image,cw_-1_0.5,1-50Hz_time=-0.025.svl
image,cw_-1_0.5,1-50Hz_time=-0.020.svl
image,cw_-1_0.5,1-50Hz_time=-0.015.svl
image,cw_-1_0.5,1-50Hz_time=-0.010.svl
image,cw_-1_0.5,1-50Hz_time=-0.005.svl
image,cw_-1_0.5,1-50Hz_time=-0.000.svl
```

Example of saved image list from group beamformer:

AL_BH_L2R_error_long.ds/ANALYSIS/wimage,4-8Hz_A=0_0.5,B=-1_-0.5_T.nii
CW_BH_L2R_error_long.ds/ANALYSIS/wimage,4-8Hz_A=0_0.5,B=-1_-0.5_T.nii
**Voxel Files (.vox)**

A voxel file (.vox) contains the number of voxels followed by the voxel location and associated source orientations (in MEG coordinates) for volumetric images. This file is only used internally by *BrainWave*, but can be used to determine the optimized dipole orientation for scalar beamformer images. Contents of a typical voxel file are as follows:

```
39237
-10.00 -8.00  0.00  -0.203  -0.446  0.872
-10.00 -8.00  0.50  -0.102  -0.500  0.860
-10.00 -8.00  1.00   0.625  -0.776  0.086
-10.00 -8.00  1.50   0.693  -0.478  -0.539
-10.00 -8.00  2.00   0.680  -0.725  -0.111
-10.00 -8.00  2.50   0.526  -0.773  0.356
-10.00 -8.00  3.00   0.463  -0.735  0.495
-10.00 -8.00  3.50   0.626  -0.521  -0.580
-10.00 -8.00  4.00   0.665  -0.675  -0.320
-10.00 -8.00  4.50   0.651  -0.758  0.040
```

Voxel List (.vs)

This voxel list file (.vs) contains a list of dataset names, the covariance dataset used, and their respective voxel locations and orientations in (MEG coordinates). It can be generated using a text editor, or generated automatically when Talairach coordinates are unwarped during virtual sensor analyses. An example of a .vs file:

```
AB_switch.ds AB_switch.ds  5.5  -3.0  4.5   0.267  -0.020  0.964
AL_switch.ds AL_switch.ds  5.5  -2.5  5.0   0.234  0.442  0.866
```

<end of file>
Old Voxel List Files (.vlist)

Compatible for old BrainWave versions. This voxel list file (.vlist) contains a list of dataset names and their respective voxel locations and orientations in (MEG coordinates). It can be generated using a text editor, or generated automatically when Talairach coordinates are unwarped during virtual sensor analyses. An example of a .vlist file:

- AB_WH_I2M_switch.ds 5.5 -3.0 4.5 0.267 -0.020 0.964
- AL_WH_M2I_switch.ds 5.5 -2.5 5.0 0.234 0.442 0.866
- CM_WH_I2M_switch.ds 7.0 -0.5 4.0 0.210 0.394 0.895
- CW_WH_M2I_switch.ds 7.0 -2.5 4.5 0.003 0.539 -0.842
- DC_WH_M2I_switch.ds 5.0 -2.0 5.5 0.322 0.912 0.254
- JD_WH_I2M_switch.ds 6.0 -2.5 4.5 0.210 0.556 0.804
- ML_WH_M2I_switch.ds 5.0 -0.5 6.5 0.037 0.999 0.007
- PF_WH_M2I_switch.ds 7.5 -1.5 5.5 -0.051 0.056 0.997
- ST_WH_I2M_switch.ds 4.5 -1.0 4.0 0.272 -0.046 0.961
- SW_WH_I2M_switch.ds 7.0 -2.5 5.0 0.261 0.285 0.922
- WW_WH_I2M_switch.ds 6.5 -0.5 3.5 0.209 0.759 0.617
- ZH_WH_M2I_switch.ds 6.5 -3.0 4.5 0.022 0.312 -0.950

Virtual Sensor Raw Data Files (.ave and .raw)

The data values for a virtual sensor can be saved to ASCII files from the BrainWave menu in the plot window, or from the “Save Raw Data” Menu option in the Group Virtual Sensor module. The format of the files for averaged data is 2 columns x $M$ samples. The first column is the sample latency and the second column the value at that latency (in nAm or pseudo-Z). For single trial (.raw) data there is one column per trial or ($N$ trials + 1) columns x $M$ samples. (i.e., column 1 = latency, column 2 = trial 1, column 3 = trial 2, as shown below:

(average file)

```
-4.0000  -0.90167
-3.9984  -1.77684
-3.9968  -2.68678
-3.9952  -3.55801
-3.9936  -4.32657
```

```
nsamples
```
BrainWave v3.5

(.raw file)

-4.0000  -2.32345  2.32345  3.32345  -6.37533  1.32345 ... ntrials
-3.9984  -2.12303  3.76345  4.23423  -6.32412  1.43123 ... ntrials
-3.9984  -2.43292  3.92384  4.17323  -6.34394  0.45674 ... ntrials
-3.9936  -2.43212  3.88821  3.00234  -7.14323  0.11342 ... ntrials

BrainWave Settings File MAT-file (.mat)

A settings file used by BrainWave is a MATLAB format MAT-file that is used to save or re-load data parameters and options. It consists of three main structures that contain beamformer parameters, virtual sensor parameters and TFR parameters, plus various other settings that can be used to return BrainWave to a previous state. The settings file can be viewed in MATLAB as follows:

```plaintext
>> t = load('theta_error_params.mat');
```
or can be called directly in matlab to get default parameters as follows:

```plaintext
>> [beam_params vs_params tfr_options] = bw_setDefaultParameters
```

beam_params =
```
    rms: 0
    stepSize: 0.4000
    boundingBox: [-10 10 -8 8 -2 14]
    nr: 0
    pm: 0
    mean: 0
    covWindow: [0 0]
    noise: 3.0000e-15
    regularization: 0
    useBaselineWindow: 0
    baseline: [0 0]
    filter: [1 50]
    filterData: 1
    useAngleWindow: 0
    hdmFile: "
    useHdmFile: 0
    sphere: [0 0 5]
    beam: [1x1 struct]
```

vs_params =
```
    raw: 0
    rms: 0
    pseudoZ: 0
    autoFlip: 0
```
autoFlipLatency: 0
useSR: 0
searchRadius: 10
searchLatency: 0
searchMethod: 'ERB'
searchActiveWindow: [0 0]
searchBaselineWindow: [0 0]

tfr_options =
    freqStep: 1
fOversigmaRatio: 5
plotType: 0
plotUnits: 2
    baseline: [0 0]

**Covariance File (.cov)**

The covariance file is an ASCII file of the data covariance for a given covariance window and bandpass. *BrainWave* stores calculated covariance data in these files to speed up repetitive computations since the covariance for a given time period and frequency band only needs to be computed once. The file is stored in the .ds folder with a specific naming convention. E.g., *PF_BH_L2R_default_w_-1_0.5_4_8Hz.cov*.

**NOTE:** These files are not in the same format as the .cov files used by the CTF Omega software SAM Suite.

**Average File (.ave)**

The average file is an ASCII file of the data average for a given data bandpass. *BrainWave* stores average data in these files to speed up repetitive computations since the covariance for a given time period and frequency band only needs to be computed once. The file is stored in the .ds folder with a specific naming convention. E.g., *PF_BH_L2R_default_1_50Hz.ave*.

**SAM Volume (.svl)**
The SAM Volume file is binary format used to store the volumetric beamformer images. It is completely compatible with the .svl format used by the CTF Omega Software for storing SAM images. Thus, beamformer images computed with BrainWave can be used with CTF software (E.g., MRIViewer).

**Head Model File (.hdm)**

The Head Model File (.hdm) is a simplified version of the head model files used in the CTF Omega software package. They specify the origin of the conducting sphere (in cm) corresponding to each MEG sensor for multiple (overlapping) spherical models used by the MEG forward solutions. Note that a single sphere model can be specified using an .hdm file, by simply specifying the same sphere origin for each sensor. The .hdm file for BrainWave can simply include a list of sensor names and sphere origins and radii as in the example below. However, .hdm files created with the CTF Omega Software can be used as well (although any additional information in these files is ignored). It should be noted that the radius is provided for each sphere, since it is usually calculated for the determination of the sphere location, but is not actually used in the forward model (see Appendix 3).

**NOTE:** in the example below sphere parameters must also be specified for the reference channels for CTF Omega system data so that appropriate corrections for synthetic gradient noise reduction can be applied to the forward solution.

```
BG1: 0.045 -0.232 5.444 7.041
BG2: 0.045 -0.232 5.444 7.041
BG3: 0.045 -0.232 5.444 7.041
BP1: -0.036 0.351 5.597 6.884
BP2: -0.036 0.351 5.597 6.884
BP3: -0.036 0.351 5.597 6.884
```
**NIfTI and Analyze Files (.nii and .hdr, .img)**

These are standard volumetric image files used by the SPM software package to manipulate MRI and other functional images. SPM5 and later use the NIfTI format, whereas SPM2 can only read Analyze format images. BrainWave converts the .svl functional images and .mri anatomical images to NIfTI or Analyze format for spatial normalization by SPM. For further details on these formats see [http://www.grahamwideman.com/gw/brain/analyze/formatdoc.htm](http://www.grahamwideman.com/gw/brain/analyze/formatdoc.htm) or [http://nifti.nimh.nih.gov](http://nifti.nimh.nih.gov). For conversion to NIfTI format we use the tools provided by Jimmy Shen at Rotman Research Institute in Toronto [http://www.rotman-baycrest.on.ca/~jimmy/NIFTI/](http://www.rotman-baycrest.on.ca/~jimmy/NIFTI/).
**Files used by SPM for Spatial Normalization (.nii and *_sn3d.mat)**

Two files are created during spatial normalization using SPM. The .mri file is first spatially resampled using fast trilinear interpolation into the function beamformer image volume and saved in NIfTI format. This image file is specific to the bounding box used and for the standard bounding box will be named <SUBJECTID>_resl_-10_10_-8_8_0_14.nii. This image is then used by SPM to generate the warping using the spm_normalize function that generates a MAT-file with a similar name <SUBJECTID>_resl_-10_10_-8_8_0_14_sn3d.mat. Once this .mat file is created, *BrainWave* will look for and use this file for spatial warping of volumetric images, eliminating the need to recomputed the warping parameters every time.

**Surface Voxel Files (*.txt)**

The surface voxel ASCII (.txt) files contain a single column, where each row contains a single value corresponding to the source strength (e.g., pseudo-Z value) at each vertex in the surface mesh (SURFACE.mat file). These are in the same order as the vertices are listed in the mesh file. These are created automatically (instead of .svl files) when generating a 3D surface beamformer with CIVET or Freesurfer surfaces. An example file:

```
0.619512
0.578624
0.581981
0.384803
0.240961
0.369745
0.541962
0.275998
```

...
<end of file>
Appendix 4

APPENDIX 4: CIVET and FreeSurfer Surface Files

Which Surface Files Should I Use?

When selecting the surface files you will have the choice of using the surface corresponding to the gray matter – CSF boundary (termed the ‘gray’ or ‘pial’ surfaces in Freesurfer and CIVET, respectively) or the white matter – gray matter boundary (termed the ‘white’ surfaces in both Freesurfer and CIVET). CIVET also provides by default a ‘mid-surface’, which is literally the mid-point between the same vertex on the gray and white surfaces.

There are several issues to consider when selecting a surface for source reconstruction. Basically it should be what most closely represents the points in space where the true sources reside. The white surface is typically recommended in some source reconstruction packages (e.g., MNE) as it places the reconstruction points slightly deeper in the cortex and also results in surfaces (and sources) that are not extremely close to each other. It also has the advantage of making activity buried in the sulci visible on 3D rendered images. However, the use of inflated brain viewing option allows sources on these surfaces to be visible in the viewer. In addition when using Freesurfer surfaces, light-dark gray shading is displayed on the inflated surface to provide a reference to gyral anatomy.

We find that the mid-surface provided by CIVET is a good compromise, and sulcal activity tends to be visible without inflation. However, the
CIVET software does not provide an inflated surface and curvature maps similar to that provided by FreeSurfer. In the current release, a “semi-inflated” CIVET mesh is computed during the import procedure. In the next release, it will be possible to project both FreeSurfer and CIVET source images onto a FreeSurfer based template brain with inflation and curvature maps.

IMPORTANT NOTE ON CIVET/FREESURFER FILES
Both CIVET and FreeSurfer provide sufficiently detailed cortical surface meshes for cortical source reconstruction, but differ in some key ways. Default FreeSurfer cortical surface extractions have a much higher resolution (> 100,000 vertices per hemisphere) that will both increase images computation time and file sizes, and result in slower graphics updates when viewing the source images in the 4D viewer. CIVET uses a fixed number of vertices (by default 81,920 vertices per hemisphere) for every subject. More importantly, these vertices are (more or less) aligned in Talairach space across subjects which makes group averaging straightforward, eliminating the need to resample individual subject images to a standardized mesh for averaging. FreeSurfer meshes have arbitrary numbers of vertices across subjects (but the same for different surfaces within subjects). Thus averaging source images across subjects requires projecting or interpolating each image onto a common surface.

For the initial release of the surface beamformer in BrainWave (version 3.0beta) plotting a group average of surface based source images is only possible using CIVET meshes. Group averaging using interpolation of FreeSurfer images to a template brain is under development and will be available in the next software update.

The import procedure performs a number of operations. It will combine left and right hemisphere meshes into a single source space model. It will
also save the MRI (RAS) based cortical mesh vertex coordinates in both
MEG and Talairach coordinates (using the transforms provided in the
CIVET or Freesurfer subject directories), as well inflated meshes for
viewing source images in the new 4D surface viewing module (see
Program Navigation section on Generated Figures/Images). The
Freesurfer curvature maps are also incorporated into the .mat file for
viewing inflated Freesurfer meshes. When the desired surface .mat file is
selected in the beamformer image options, the vertices of the selected
surface mesh are used to create the reconstruction space (.vox file) that
will consist of a dipole source at each vertex.

In addition, “orientation” vectors are computed for each vertex. These
represent the directions normal to the cortical surface at each vertex.
This can be optionally used to constrain the current direction at each
vertex (voxel) to be in this direction (rather than derived from the data
using the optimal orientation setting in the beamformer options). The
normal vectors for each vertex are computed from the mean of the
surrounding face normal. This is typically a time-consuming computation
but been optimized using a compiled C-mex function in BrainWave and
only takes a few seconds to compute even for large meshes.
APPENDIX 5: How *BrainWave* uses Continuous Head Localization (CHL)

*BrainWave* will allow you to minimize the effect of head motion on source localization accuracy using the CHL data in two ways:

1) **Using the Mean Head Position:**

For source localization, *Brainwave* defines the position and orientation of the MEG sensors (e.g., gradiometers) in a head based frame of reference identical to that used by the CTF software (i.e., the coordinate system defined by the Na, Le and Re fiducials coils as defined in the CTF software documentation). For CTF data this is determined by the “head localization” runs done at the beginning and end of each data acquisition, using by default, the mean of the two head positions. That is, even if CHL is enabled, the continuous head position data that is stored with the data is not utilized by most software applications (with the exception of some features of the CTF DipoleFit program). If CHL data is available, *BrainWave* will optionally allow you to use instead the “true head position” based on the mean position of the fiducial coils over the selected epochs during the epoching procedure. This provides a head position that reflects the actual head position for the data being analyzed, i.e., will exclude any large head movements between trials, or that may have occurred during the pre and post head localization recordings. The adjusted sensor geometry (i.e., gradiometer position and orientations) are saved in the .res4 file and the
new fiducial locations saved in the .hc file in the epoched dataset. The updated overall head motion statistics after this adjustment are printed to the command window.

2) Rejecting Trials using Mean Sensor Motion

Brainwave will also allow you to use continuous head localization data to reject trials where excessively large head movements may have occurred which can result in increased localization error. Although the movement of the fiducial head coils in dewar coordinates can be used to determine head motion, the overall effect on sensor co-registration is complicated by the fact that head motion can be both translational (left, right, up, down) and rotational. In the latter case, one coil may move more than others depending on the nature of the motion, and these may effect the position of some sensors more than others. E.g., tilting or nodding of the head may result in very little Le and Re coil motion with large motion of sensors over the front of the head and less over the temporal regions. This makes it difficult to select a single coil position parameter to determine the net effect on the forward solution. *BrainWave* using a different approach by computing the motion of the sensors relative to the head and rejecting trials based on this sensor motion, rather than the motion of the fiducial coils relative to the dewar. By default, the mean (RMS) motion of all primary sensors is used to determine the allowable movement threshold, and also indicates how head motion errors are averaged over the entire sensor array. One can select a subset of channels (e.g., overlying a source of interest) to provide more selective correction for movements. Note that any purely translational motion will be detected independently of the channel selection, and will have same effect as measuring the mean motion of all coils. The default
allowable mean sensor motion is set to 5 mm as a conservative estimate, however, larger values may be used if localization accuracy is less important than increasing the number of epochs and resulting SNR. In practice, you may find that in many cases mean sensor motion is relatively small even when large deviations of one or more head coils are observed during recording. When used in combination with the Use Mean Head Position option, sensor motion is relative to the corrected rather than the original head position.
Event-related beamformer images and virtual sensor calculations are based on algorithms described in:


Differential images and pseudo-Z normalization based on the SAM algorithm described in:


Forward solutions are based on spherical conductor dipole model:


Permutations Tests

